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Abstract 

 

This document presents digital signal processing formulations and computing 

methods using the DSP processor TMS320C6711, of Texas Instruments, to implement 

multirate systems with discrete and finite length signals. In many digital signal 

processing applications  sampling rates need to be changed for high computational 

efficiency  losing the desired information carried by the signal. These multirate systems 

play an important role in many engineering and communications applications such as 

sensor arrays, beamformnig, FIR filters, filter banks, time frequency representations and 

systems with associated diverse sampling rates. Special emphasis is given to the concepts 

of modularity and scalability during the hardware implementation.  

The main goal of this work consists in reducing the sampling rate to control the 

lose of desired information in a communication signal. In order to obtain only the desired 

information stored in the original communication signal with associated lower 

computational effort. The implementation of these concepts was made on the DSP 

processor TMS320C6711 of Texas Instruments.  Finally a multirate beamforming with 

32 sensors were implemented on the DSP processor using simulated data from Matlab®. 
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Resumen 

 

 Este documento presenta formulaciones de procesamiento digital de señales y 

métodos computacionales usando el procesador TMS320C6711 DSP de Texas 

Instruments para implementar sistemas multi-frecuencia de muestreo con señales 

digitales y de finita duración. En muchas aplicaciones de procesamiento digital de señales 

la frecuencia de muestreo necesita ser alterada para una mayor eficiencia computacional 

perdiendo solo la información que se desea de la señal portadora . Estos sistemas de 

multi-frecuencia juegan un papel muy importante en muchas aplicaciones de 

comunicaciones e ingeniería tales como: arreglos de sensores, “beamforming”, filtros 

FIR, bancos de filtros, representaciones tiempo frecuencia y sistemas con diversas 

frecuencias de muestreo. Un énfasis muy especial es dado a los conceptos de 

modularidad y escalabilidad durante la implementación del hardware.  

El objetivo más importante de este trabajo consiste en reducir la frecuencia de 

muestreo de una señal teniendo el control de la información que se pierde en una señal de 

comunicaciones. Para entonces obtener solo la información deseada con una asociada 

disminución en el esfuerzo computacional. La implementación de estos conceptos fueron 

hechos utilizando el procesador TMS320C6711 de Texas Instruments. Finalmente un 

sistema de multi-frequencia de muestreo y “beamforming” con 32 sensores fue 

implementado en el procesador DSP usando datos simulados desde Matlab®. 
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Chapter 1 
 
Introduction 
 

This work deals with the formulation of computing methods for the action of 

multirate systems on discrete and finite length signals where the sampling rates need to 

be changed for high computational efficiency. These multirate systems play an important 

role in many engineering and communications applications such as sensor arrays, 

beamformnig, FIR filters, filter banks, time frequency representations, and systems with 

associated diverse sampling rates. 

 

Kronecker Structured Multirate (KSM) offers the mathematical framework of this 

Signal Processing System. It explains, with matrix formulations, different 

representations, operations, and transformations of communications signals represented 

by vectors. 

 

Sensor Arrays consist of a set of sensors that spatiotemporally measure a 

wavefield. Several sensors, sampling a common wave field, may be merging to produce 

more refined information about the communication signals. 

 

The emphasis of this work is about modular and scalable computing methods, for 

signal processing applications using Digital Signal Processors (DSP). The modular and 

scalable approach implies that the functions and structures of the algorithmic treatment 

should adapt to changes in the scales of an associated system, and the size or 
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dimensionality of the signals to be processed. The fundamental information obtained by 

our algorithms are important variables involved in communications signal processing 

systems to quantify, represent, transform, encode, decode, qualify information-carried   

and obtained by sensor arrays.  

 

Algorithm is defined as a procedure to solve a problem in a finite number of steps. 

A problem is anything which requires a solution. Multirate systems are defined as 

systems that can increase or decrease the sampling spacing (and thus the sampling rate) 

of individual signals before, or while, processing them. Communications signal 

processing is described here as an area dealing with the analysis, design, and 

implementation of circuits, signals, and systems for the transmission and reception of 

communications signals. A communications signal is defined as a information coded by a 

signal, appearing in any of the stages of an arbitrary communication system.  This work 

concentrates on Multirate systems for digital communications and the way to implement 

this concept using sensor arrays technology. 

 

1.1 Previous Work 

 

The interest of this work is in applications in which signal enhancement can be 

achieved by processing the waveform received by a single sensor, but often it is 

advantageous to use an array of sensors using multirate techniques. The treatment of a 

desired signal is mostly done through algorithmic techniques implemented on physical 

DSP units. The technology used to make the processing of digital signals varies from PC 
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workstations, matrix software development tools, until digital signal processors (DSP) 

units. Some of the most relevant publications are associated with the development of 

algorithm formulations based on Kronecker products and multirate techniques related to 

sensor arrays and their implementation as described below. 

 

J. Jonson, R. W. Jonson, D. Rodríguez, and R. Tolimieri proposed a methodology 

for designing, modifying, and implementing Fourier transform algorithms on various 

architectures [1]. In 1990, they presented all the descriptions and properties of tensor 

products (Kronecker products) that will play a major role in the design and 

implementation of Fourier transform algorithms. The formalism of tensor product 

notation can be used to keep track of the complex index calculation needed in Fourier 

transform algorithms. 

 

D. B. Ward, Z. Ding, and R. A. Kennedy proposed a broadband DOA estimation 

using frequency-invariant beam-space processing [2]. In 1995, they presented a new 

method of beam-space direction of arrival (DOA) estimation for multiple far-field 

broadband signals. A novel multirate beamforming structure having a frequency invariant 

property is applied to the array outputs. 

 

D. B. Ward, R.A. Kennedy and R. C. Williamson proposed a theory and design of 

broadband sensor arrays with frequency invariant far-field beam patterns [3]. In 1998, 

they presented the frequency invariant beam pattern property defined in terms of a 

continuously distributed sensor, and the problem of designing a practical sensor array 
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was treated as an approximation to this continuous sensor using a discrete set of filtered 

broadband omni directional array elements. The design methodology is suitable for one-, 

two-, and three-dimensional array elements based in multirate techniques. 

 

M. Ghavami and R. Kohomo, proposed a rectangular arrays for uniform wideband 

beamforming with adjustable structure [4]. In 2000, they presented the increasing of the 

demand for different broadband services and applications that was a key problem of the 

future mobile communications system. Because the limitations of the available spectrum 

for providing high data rate communications for new cellular scribers, it is predicted that 

the application of smart antennas can increase the system capacity and performance. 

 

A. Quichanegua and D. Rodríguez, proposed a Kronecker DFT multi- beamforming 

implementation approach [5]. In 2003, they present a new methodology for the hardware 

implementation of multi-beamforming algorithms based on Kronecker products 

decomposition. Kronecker products algebra was used in this work as a tool language to 

identify integrated and coherent manner similarities and differences between fast Fourier 

transform (FFT) algorithm formulation in order to achieve efficient hardware core 

implementation. 

 

J.C Chen, L.Yip, H. Wang, D. Maniezzo, R.E. Hudson, J. Elson, K. Yao and D. 

Estrin proposed a DSP implementation of a distributed acoustical beamforming on a 

wireless sensor platform [6]. In 2003 they proposed to perform beamforming based on 

coherent processing of acoustical waveforms collected from the sensor nodes for 
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detection, localization, tracking, identification, and signal to noise ratio (SNR) 

enhancement of acoustical sources counting the number of such sources and estimating 

the impulse responses of the acoustical channels. 

 

1.2 Justification 

 

The function of a Multirate system is to alter the sampling rate (up-sampling/down-

sampling) of discrete-time signals to give a new sampling rate for other signal processing 

system. This new sampling rate offers the system, the possibility to perform their 

operations spending lower computational effort. The lower computational effort is 

obtained because the new length of the communication signal to be processed decreases 

with respect to the original sampling rate, this is associated directly with the number of 

points or samples of the original communication signal. 

 

The main goal of this work consists in reducing the sampling rates but controlling 

the lose  information of the original communication signal, in order to extract the relevant 

information stored on the original communication signal with the associated lower 

computational effort. The implementation of this concept was made using the DSP 

processor TMS320C6711 of Texas Instruments using an array of microphones and A/D 

converters. For complete characterization of sound phenomenon, time-frequency 

algorithms were implemented in order to obtain the truth capability of this floating point 

hipper performance processor.  The theoretical framework is based on Kronecker 

products and the physical structures are based on sensors array. 
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1.3 Thesis Objectives 

 

• Understand the concepts of multirate signal processing, sensor arrays and 

Kronecker Array Signal (KAS) algebra as a language for computational signal 

processing systems. 

• Learn about Matlab tools, DSP architectures, PC-stations, in the field of multirate 

and sensor arrays. 

•    Develop algorithms for multirate sensor arrays, based on the characteristics of 

modularity and scalability. 

• Map different algorithms into DSP units during the implementation process. 

 

1.4 Research Methodology 

In order to achieve the proposed objectives of this thesis, we fallow method bellow: 

• Review and research of the literature and fundamental principles involved in 

digital signal processing, multirate signal processing, sensor arrays, filters banks 

and Kronecker mathematical formulations, in order to observe, quantify, 

represent, transform, qualify and render information-carrying signals in our sensor 

arrays reality.  This step involves analysis and synthesis of the theoretical 

information and identification of specific hardware and software tools used for 

digital signal processing applications. 
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• Define the mathematical formulation based on Kronecker products to develop 

algorithms as operations matrix-vector, using MATLAB (witch stands for 

MATrix LABoratory). 

• Selection and learning of software and hardware tools for development and 

implementation of the algorithms to achieve multirate sensor arrays. In this step 

we will define the environment of development and implementation of the 

algorithms for DSP units. This environment will be used throughout the PC 

Workstation platform, MATLAB tools, and digital signal processing (DSP) 

microprocessor units. 

• Mapping algorithms developed to DSP computing units using a defined modular, 

scalable methodology. Coding the algorithms using C language. 

 

1.5 Original Contributions  

 

This work examines the implementation of multirate concepts on real DSP unit 

such as DSP320C6711, that is the last floating point DSP processor developed by Texas 

Instruments (T.I.).  It determines the capability of these units to perform signal processing 

operations based on double precision variables (64-bits), in order to evaluate execution 

time and memory capacity of this processor.   

 

In addition the work developed physical hardware implementation of sensors 

array using an array of six-microphones as unit dimensional array (ULA), developing 

hardware for a signal conditioner interface (AIP-0404-1) and obtaining real data from 
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microphones way 16-bits six- channels A/D converter (ADS8364 of T.I.). For a complete 

characterization of particular sound phenomenon.  

 

In order to evaluate the DSP320C6711’s capability of processing floating point 

variables, different signal processing algorithms for time-frequency representations were 

implemented. Some of these algorithms are Short Time Fourier Transform (STFT), 

Cyclic Correlation and Ambiguity Function (AF) using real data from A/Ds or simulated 

with Matlab®. All these algorithms and the data used are stored on a CD as a library 

resource for students working at the university DSP laboratories. Because there are  not 

tools like this provided before.   

 

Finally, as an important application a Multirate Beamforming system was 

developed using real and simulated data. This shows that the sensor array structures 

based on Kronecker products are an important tool for modularity and scalability 

approach, which are used in Radar and Sonar applications. 
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Chapter 2 

Multirate Systems 

 

 This chapter presents basic concepts on multirate systems [7]. Discrete time 

systems with unequal sampling rates, in various parts of it are called multirate systems. 

Where sampling rate needs to be converted into an equivalent signal with different 

sampling rate. To achieve this, is important to understand the concepts of down-sampling 

and up-sampling and their input and output relations in the time and frequency domain. 

The cascade equivalences for up and down sampling are then explained too. For cascade 

up and down sampling rate alterations there has to be some details given, of the use of 

lowpass digital filters. The frequency response specifications of these filters are 

developed next. A computational sampling rate implementation is then illustrated by a 

specific design problem. The DSP320C6711 processor of Texas Instruments and its 

development kit was used to perform the real implementation. 

 

2.1 The Basic Sample Rate Alteration Concepts  

 

 The two basic components in sampling rate alteration are the up-sampler and down-

sampler. Figure 2.1 shows the block diagram representation for this two components. The 

block diagram representation of the up-sampler, also called “sampling rate expander” and 

the block diagram of the down-sampler “sampling rate compressor”. 

 The L positive integer factor represents the up-samples introduced between each sample 

of the original signal x[n]  to produce the output signal y[n] , and the M positive integer 
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factor represents the down-samples taken from the original signal x[n] to produce the 

output signal y[n] . 

 

 

Figure 2.1 Block diagram representation for a) Up-sampling, b) Down-sampling 
 
 

2.1.1 Time Domain Characterization 

 

 An up-sampler with an up-sampling factor L, where L is a positive integer, develops 

an output sequence y[n] with a sampling rate that is L times larger than the input 

sequence x[n] . This operation is implemented by inserting L – 1 equidistant zero-valued 

samples between two consecutive samples of the input sequence x[n] according to the 

relation 



 ±±=

=
otherwise

LLnLnx
ny

;0

,....2,,0];/[
][ .   (2.1) 

The up-sampling operation is illustrated in Figure 2.2 using Matlab®.  

In a real application, the zero-valued samples inserted by the up-sampler are replaced 

with appropriated values interpolated using filtering process. This makes the new higher-

rate sequence useful. This process is called interpolation, and will be discussed later in 

this chapter.   
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Figure 2.2 Illustration of the L↑=3, up-sampling process.  

 

 Furthermore, the down-sampler with a down-sampling factor M, where M is a 

positive integer,  obtains an output sequence y[n] with a sampling rate that is (1/M)th of 

the input sequence x[n] . The down-sampling operation is implemented by keeping every 

Mth sample of the input sequence and removing M-1 in-between samples, to generate the 

output sequence according to the relation 

][][ nMxny = .     (2.2) 

As a result, all input samples with indices equal to an integer multiple of M, are retained 

at the output and all others are discarded, as shown in Figure 2.3 . 
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Figure 2.3 Illustration of the M↓=2, down-sampling process.  

 

The up-sampler and the down-sampler are linear but time-varying discrete system. 

Down-sampling time-varying property is demonstrated for 

][][ 01 nMnxny −=  

)]([][ 00 nnMxnny −=−  

][][ 10 nyMnMnx ≠− .          (2.3) 

 
Up-sampling time-varying property is demonstrated for 

]/[][ 01 nLnxny −=  

)](/1[][ 00 nnLxnny −=−  

              ][]//[ 10 nyLnLnx ≠− .             (2.4) 

 

The linearity property of down-sampling is demonstrated using superposition  

][][ Mnxny =  

][][][ 213 MnxMnxnx βα +=  

][][][][][][ 321213 nxMnxMnxMnyMnyny =+=+= βαβα .(2.5) 
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The linearity property of up-sampling is demonstrated using superposition   

]/[][ Lnxny =  

]/[]/[][ 213 LnxLnxnx βα +=  

][]/[]/[]/[]/[][ 321213 nxLnxLnxLnyLnyny =+=+= βαβα .      (2.6) 

 

2.1.2 Frequency Domain Characterization 

 

 For better understanding we first derive the relations between the spectrums of the 

input and the output for a factor of L=2 up-sampler. 

If  



 ±±=

=
otherwise

LLnnx
ny

;0

,....2,,0];2/[
][ .     (2.7) 

In terms of the z-transform, the input-output relation is then given by 

∑∑ ==
∞

−
−∞=

−∞

−∞=

−

evenn
n

n

n

n znxznyzY ]2/[][)( ,   (2.8) 

replacing m=n/2 

∑ =
∞

−∞=

−

m

m zXzmx )(][ 22
.    (2.9) 

In general it can be said that for a factor of L up-sampler the output z transform of the 

output with respect to the input is given by  

)()( LzXzY = ,              (2.10) 

for ωjez = the above equation becomes 

)()( Ljj eXeY ωω = ,                                            (2.11) 
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indicating that the Fourier transform is compressed by a factor of L, in this case L↑=2. 

This process is called “imaging” because we get L-1 additional image of the input 

spectrum in the base band. Figure 2.4 shows the normal spectrum of the input signal x[n] , 

then this signal is up-sampling by L↑=2, Figure 2.5 shows the output signal y[n] and the 

correspond spectrum with the imaging of the original spectrum.   

 

 

Figure 2.4 Input sequence and input spectrum for x[n] .  

 

 

Figure 2.5 Output sequence and output spectrum for y[n] . 
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For L↑=3 Figure 2.6 shows the original input spectrum and correspond L-1 spectral 

imaging of the output.   

 

Figure 2.6 Input and output spectrum, Up-sampling by L↑=3. 

 

Now we derive the relations of the input and output spectrums relations of a down-

sampler, applying the z-transform. 

If  

][][ Mnxny =  

∑=
∞

−∞=

−

n

nzMnxzY ][)( .   (2.12) 

The right hand equation cannot be directly expressed in terms of X(z). An intermediate 

sequence xint[n]  is used 



 ±±=

=
.;0

2,,0],[
][int otherwise

MMnnx
nx         (2.13) 

Then  
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∑∑ ==
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−
.  (2.14) 

Now if xint[n]  can be related to x[n]  through  xint[n]  = c[n]x[n] , where c[n] is defined by 



 ±±=

=
.;0

2,,0;1
][

otherwise

MMn
nc    (2.15) 

A convenient representation of c[n]  is given by  

∑=
−

=

1

0

1
][

M

k

kn
MW

M
nc .    (2.16) 

where  Mj
M eW /2π−= . Substituting in xint[n]  = c[n]x[n]  and making use of z-transform of 

xint[n], we obtain 
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From ][)( /1
int

MzXzY = , we get 

∑=
−

=

−1

0

/1 ][
1

)(
M

k

k
M

M WzX
M

zY .   (2.18) 

To understand the implication relation of the above relation, we can consider the case of 

down-sampler M↓=2, by replacing  ωjez =  then 

∑=
−

=

−12

0
2

2/1 ][
2

1
)(

k

kWzXzY ,   (2.19) 
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expanding and replacing we get 

{ }2/)2(2/ ()(
2

1
)( πωωω ++= jjj eXeXeY .   (2.20) 

The output spectrum expresses the original spectrum of x[n]  expanded by 2, and the same 

expanded spectrum shifted byπ2 . Figure 2.7 shows the input sequence and spectrum of 

x[n] , Figure 2.8 shows the output sequence and spectrum of down-sampling by M↓=2. 

 

 

Figure 2.7 Input sequence and spectrum of x[n]. 

 

Figure 2.8 Output sequence and spectrum of y[n] , down-sampling M↓=2.  
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We need to consider that  if the original spectrum )( ωjeX of the input sequence x[n] is 

non zero for 2/πω ≥ , this causes an overlap and the output spectrum experiments 

“aliasing”, that takes place due to undersamplig. Figure 2.9 shows an input sequence x[n] 

with spectrum )( ωjeX  and 2/πω ≥ , the output experiments “aliasing”. 

 

 

Figure 2.9 Input sequence and spectrum of x[n], with non zero for 2/πω ≥ . 

 

Figure 2.10 Output sequence and spectrum of y[n] , with aliasing effect. 
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2.2 Cascade Connections 

 

 The complex multirate system is formed by an interconnection of basic sample rate 

alteration devices and the components of an LTI digital filter. In many applications these 

devices appear in cascade form, because not only integer up or down sampling rate is 

needed Furthermore some applications use up/down or down/up fractional rates as shown 

in Figure 2.11.  

 

 

Figure 2.11 Cascade arrangements a) up/down sampler b) down/up sampler. 

 

2.3 Filters in Sampling Rate Converters Systems 

 

 From the sampling theorem, it is known that the critical sampling rate of a discrete 

time signal with spectrum occupying the full Nyquist range, cannot be reduced any 

further. This is because such reduction will introduce aliasing. For that reason, the 

bandwidth of a critically sample signal must be reduced by lowpass filtering, before its 

sampling rate is reduced by a down sampler. Likewise, the zero-valued samples 
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introduced by an up-sampler must be interpolated to more appropriate values for an 

effective sampling rates increase. Also, this interpolation can be simply achieved by 

digital lowpass filtering. 

 

2.3.1 Filter Specifications 

 

 Since up sampling causes periodic repetition of the basic spectrum as shown in 

Figure 2.5, the unwanted images in the spectra of the up-sampled signal y[n]  must be 

removed by using a lowpass filter Hi(z), called the “interpolation filter” Figure 2.12(a). 

On the other hand, as indicated in Figure 2.12(b), prior to down sampling, the signal 

v1[n]  should be bandlimited to  M/πω ≥  by means of a lowpass filter Hd(z), called the 

“decimation filter”, to avoid aliasing caused by down sampling process. 

 

 

Figure 2.12 Filters in sampling rate alteration a) interpolator and b) decimator. 

 

 The specifications of the interpolator filter Hi(z) are based on the bandwidth  of the 

spectrums of x[n]  → )( ωjeX  Figure 2.13(a), v1[n]  → )( LjeX ω , )( ωj
i eH  Figure2.13(b) 



  21  

   

and )(1
ωjeY  Figure 2.13(c). In practice, a transition band is provided to ensure the 

realizability and stability of the lowpass interpolation filter  )( ωj
i eH  with a cut 

frequency at L/π  and gain L, the output of the filter will be precisely y[n] . Hence,  the 

desired lowpass filter should have a stopband edge at Ls /πω = and a passband edgepω  

close to the stopband sω  to reduce the distortion of the spectrum of the signal x[n]  . If cω  

denotes the highest frequency that needs to be preserved in the signal to be interpolated, 

the passband edge pω  of the lowpass filter should be at Lcp /ωω = . The specifications 

for the lowpass interpolation filter are thus given by  







≤≤

≤=
=

πωπ
ωω

ω

L

LnL
eH

cj
i

/;0

/;
)( .   (2.21) 

 

Figure 2.13 Spectrum of a) the input x[n] , b) the output v1[n] and interpolator filter for 

                     L↑=3, and c) the output y[n] . 
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In a similar manner, the developed specifications of the lowpass decimation filter are 

given by  







≤≤

≤=
=

./;0

/;1
)(

πωπ
ωω

ω

M

Mn
eH

cj
d        (2.22) 

The two digital lowpass filters studied before and their specifications, guarantee the 

complete information reproduction of the input signal with the associated frequency 

sampling Fs1, and the output signal with the associated frequency sampling Fs2, for up 

sampling Fs2 > Fs1 and for down sampling Fs2 < Fs1. 

 

2.3.2 Filter for Fractional Sampling Rate Converters 

 

     A fractional change in the sampling rate can be achieved by cascading a factor of  

M↓ decimator with a factor of L↑ interpolator, where M and L are positive integers. Such 

cascade is equivalent to a decimator with a decimation factor of M/L.  There are three 

possible cascade connections, as shown in Figure 2.14. Of these two, the 2.14b) is more 

efficient since only one of the filters, Hi(z) or Hd(z), is adequate to serve as the 

interpolation filter and the decimation filter, depending on which one of the two stopband 

frequencies, L/π  or M/π is a minimum. It should be noted in Figure 2.14a) that in 

general, preserve less of the signal’s frequency content than the one on Figure 2.14b), 

because the multirate system starts with a lowpass filter to reduce the spectral content of 

the input signal in order to avoid aliasing. Hence, the desired configuration for the 

fractional sampling rate alteration is as indicated in Figure 2.14c), where the lowpass 

filter Hi(z) has  a normalized stopband cutoff frequency at  
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






=
MLs

ππω ,min .   (2.23) 

which suppressed the imaging caused by the interpolator while, at the same time ensures 

the absence of aliasing that would be caused by the decimator. 

 

 

Figure 2.14 General schemes for increasing the sampling rate by L/M 

 

2.4 A Real Computational Implementation on DSP processor TMS320C6711  

 

This implementation consists of a fractional rate change by M/L=2/3 or M/L=3/2 

from the input signal.  Based on the concepts of up-sampling, down-sampling and FIR 

(Finite Impulse Response) lowpass filters, these show the base of a Multi-rate systems, 

and proof different sample rates to know the DSP real ranges.  
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2.4.1 System Flow Chart Implementation 

 

Figure 2.15 shows the multirate system flow chart implemented on the 

DSK320C6711 (Development Starter Kid) of Texas Instruments. The steps for the real 

implementation are the following: 

 

Figure 2.15 System flow chart implemented on DSK320C6711 of T.I. 

 

Input signal:  Signal generator, microphone or music with maximum bandwidth of 

4KHz. 

1. A/D converter: Sampler input signal at a rate of 36KHz or 24KHz. 

2. Record Memory:  It stores the sampled signal into a buffer array of size 

36Ksps*8sec. or 24Ksps * 8sec. 
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3. Read from Memory:  Array to recover the samples stored in the buffer memory. 

4. Up-sampling by M:  Introduce (M-1) zeros between each sample read from the 

buffer-memory. 

5. LPF:  It removes spectral images, interpolates and limits frequency for the down-

sampling stage. 

6. Record up-sampled array: This array stores the output of the up-sampling routine. 

7. Down-sampling by L:  Reads every L sample from the output memory. 

8. D/A converter:  It converts from digital to analog with a sampling rate of 24 KHz 

or 36 KHz. 

The output signal is reproduced with the corresponding frequency sampling (Fsout), the 

output D/A converter operates at frequency 24 KHz or 36KHz.  This is obtained from the 

following relation 

L

MF
Fsout

*sin=  

KHz
KHz

outFs 24
3

2*36
1 ==  

KHz
KHz

outFs 36
2

3*24
2 == .     (2.24) 

 
2.4.2 Routines Flow Chart 
 
 
  The system algorithm is described on Figure 2.16.It defines the different stages 

and routines implemented on the DSK320C6711 using the sound daughter card 

PCM3003 of T.I. On the Appendix A the complete specifications and hardware settings 

are described. 
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Figure 2.16 System Routines flow chart implemented on DSK320C6711 of T.I. 

 

2.4.3 Multirate Results 

 

The following steps explain the different functions of the Multirate project 

implemented. 

Step # 1. 

Channel 1: Original Input Signal (Vpp = 500mv and 1 KHz). 

Channel 2: Up-Sampled Signal by 2 

Fs(in) = 36 KHz. 
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Fs(out) = 36 KHz. 

 

 

Figure 2.17 Up-sampling by two. 

 

Figure 2.17. shows in channel 2, up-sampled by 2, it has half frequency of the original 

input signal, presented in channel 1. The up-sampling process increases the size of the 

original input signal by M=2.  To show that the up sampling process works, we selected 

Fs (out) with equal value as Fs (in) so that the output signal has two times the samples 

than the original signal, and comes out with half the frequency of the original signal.  On 

the other hand is important to know that the output signal has been filtered by LPF with 

cut frequency of π/3, to interpolate the zero value samples added with the original 

samples and to eliminate the spectral images generated by the up-sampler.     

Step# 2 

Channel 1: Original Input Signal (Vpp = 500mv and 1 KHz). 
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Channel 2: Signal after Up/Down sampling processes, rate M/L= 2/3. 

Fs (in) = 36 KHz. 

Fs (out) = 24 KHz. 

Figure 2.18 shows that the signal in channel 2, after the up/down sampling processes, has 

the same frequency than the original recorded signal.  The reason for this, is that the input 

signal’s sampling frequency, Fs(in) = 36 KHz, is multiplied by the Up/Down sampling 

rate M/L= 2/3, resulting in an output sampling frequency, Fs (out) = 24 KHz.  To show 

that the Up/Down sampling processes works, we selected Fs (out) = 24 KHz in order to 

reproduce correctly the input signal.   

 

Figure 2.18   Up/Down sampling rate M/L=2/3.   

 

The signal has been filtered to eliminate the spectral images and possible aliasing created 

by the up-sampler and down-sampler respectively. The time delay for the processing of 

the complete system was shown by the shift in phase between signals of channel 1 and 2.   
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Step#  3 

Channel 1: Original Input Signal (Vpp = 500mv and 1 KHz). 

Channel 2: Up-Sampled Signal by 3 

Fs (in) = 24 KHz. 

Fs (out) = 24 KHz. 

 

Figure 2.19 Up-Sampling by M=3. 

 

Figure 2.19 shows that the signal in channel 2, up-sampled by 3, has 1/3 the frequency of 

the original input signal, presented in channel 1, because the up-sampling process 

increases the size of the original input signal by M=3.  To show that the up-sampling 

process works, we selected Fs (out) with equal value as Fs (in) so that the output signal, 

with three times the samples as the original signal, comes out with 1/3 of the frequency of 

the original signal.  The output signal has been filtered by LPF with cut frequency of π/3 
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to interpolate the zero value samples added, and to eliminate the spectral images 

generated by the up-sampler. 

Step#  4 

Channel 1: Original Input Signal (Vpp = 500mv and 1 KHz). 

Channel 2: Signal after Up/Down sampling processes, rate M/L= 3/2. 

Fs (in) = 24 KHz. 

Fs (out) = 36 KHz. 

 

Figure 2.20 Up/Down sampling rate M/L=2/3. 

 

Figure 2.20 shows that the signal in channel 2, after the up/down sampling processes, has 

the same frequency as the original recorded signal.  This is due to the input signal’s 

sampling frequency, Fs(in) = 24 KHz, which is multiplied by the up/down sampling rate 

M/L= 3/2, resulting in a output sampling frequency, Fs (out) = 36 KHz.  To demonstrate 

that the up/down sampling processes works, we selected Fs (out) = 36 KHz in order to 
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reproduce correctly the input signal.  This signal has been filtered to eliminate the 

spectral images and possible aliasing created by the up-sampler and down-sampler 

respectively.  

 

2.4.4 Lowpass filter design with MatLab 

 

We used Matlab® as a tool for the coefficients filter design. This LPF lowpass 

digital filter is used for interpolation, spectral images rejection and anti-aliasing.  We 

designed a finite impulse response FIR filter, with order of 13 and a cut frequency of   

л/3.  We used the FIR1 command to generate the coefficients used, by the 

implementation, that are located in the file COEF_CLPF.h. (see appendix A for complete 

implementation).Figure 2.21 shows Frequency and Phase response for the designed filter.  

 

Figure 2.21. Frequency and Phase Response for LPF. 
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Chapter 3 

Kronecker Products Algebra 

 

For the implementation of signal processing we designed computational 

structures. To achieve this, Kronecker products algebra, a branch in finite multilinear 

algebra which serves as an organizational language, was used. The mapping between 

Kronecker products notation and code generation for core implementations is made by 

using the mathematical properties of Kronecker products [8]. Below you will find some 

of the basic properties of Kronecker products that are key elements on the development 

and implementations of digital signal processing algorithms, such as filter banks 

algorithms and digital beamforming. 

 

3.1 Properties of Kronecker Products 

 

 Given two matrices, )( nmA × and )( lkB × , the Kronecker product is defined as 

the )( nlmk ×  matrix  
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Where srb , is the (r,s)-th element of B. this definition is in fact a left Kronecker 

product [8]. Notice that the Kronecker product of the equation (3.1) is not commutative, 

i.e., ABBA ⊗≠⊗ . This work concentrates mostly on square matrices, that is, km =  

and ln = , but the definition generally applies to matrices of any dimensions. 

We now state the key properties of the Kronecker products that are useful to 

understand matrix decompositions and further Kronecker formulations [9]. 

• Scalar Multiplication:  If α  is a scalar, then 

            )()( BABA ⊗=⊗ αα .           (3.2) 

• Distributive Law:  The Kronecker product is distributive with respect to addition 

CBCACBA ⊗+⊗=⊗+ )(       (3.3) 

)()( CABACBA ⊗+⊗=+⊗ .         (3.4) 

• Associative Law: The Kronecker product is associative 

CBACBA ⊗⊗=⊗⊗ )()( .        (3.5) 

• Identity Product : Given rcI , the cr × identity matrix, 

crrc III ⊗= .      (3.6) 

• Transpose: The transpose for both matrix and tensor operations is useful for 

manipulating symmetric matrices (e.g. the Fourier matrix), where the original 

matrix and the transpose are equal. 

TTT ABAB =)(  

TTT BABA ⊗=⊗ )(   .          (3.7) 
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• Mixed Product Rule: Let A and C be MM ×  and B and D be NN × matrices. 

Thus, 

BDACDCBA ⊗=⊗⊗ ))((  .      (3.8) 

One useful identity which follows (3.8), given  )( slD × , then  

))(()()( DIIADIAIDA NllN ⊗⊗=⊗=⊗         (3.9) 

• Let U be a 1×M  vector denoted by T
MM uuuuU ],,,,[ 1210 −= L , where 

1210 −==== Muuuu L . Then, ],[)( 1,,1,,0, −=⊗ MNNN
T
MN IIIUI L . 

 

 The action of the matrix BAC ⊗= on an arbitrary MN dimensional vector can be 

performed efficiently with the aid of the following decomposition 

))(())(( NMMN IABIBIIABA ⊗⊗=⊗⊗=⊗ ,  (3.10) 

where MI  and NI  are N and M dimensional identity matrices.  

 

3.1.1 Stride Permutation Matrices 

 

We are able to use a class of matrices called stride permutations [9], which 

commute a Kronecker product; given that Kronecker products are not commutative. 

These permutation matrices let Kronecker product formulations to be mapped to parallel 

and vector architectures, converting parallel operations )( MIB ⊗  to vector 

operations )( AI N ⊗ . Essentially, a stride permutation matrix, denoted by SNP , is a square 

matrix which its effect over a 1×N vector,  to move the components of the vector to new 
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locations using the parameter s, called the stride. The stride is related with the size of a 

vector, being SRN ⋅= , where R and S are integer numbers. Consider a 

SRSR ⋅×⋅ matrix RSRSP , represented as follows 
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.   (3.11)                                                                                                  

where the elements ),( jip of the permutation matrix are: 1),( =jip  for )1( −== RSji , and 

for )1mod( −= RSiSj , )1(0 −<≤ RSi ; 0),( =jip  for the other i,j elements. 

 

For instance, let N=4 and S=2 be the order of permutation matrix and the stride 

respectively. Then 2,222,4 ⋅= PP is generated as follows 

1),( =jip for (i,j)=(0,0), (1,2), (2,1), (3,3); 0),( =jip  for the other i,j  elements. 

The stride permutation matrix becomes 
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The action of 2,4P over a 14× vector x is represented in the expression below: 
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In general, SNP , reorders the coordinates at stride S into S consecutives segments 

of M elements, the i-th segment beginning with 1−ix . The most important property of the 

stride permutations is that they commute the factors in the Kronecker products of 

matrices. We now state some of the properties of the stride permutations.  

If  N=RS, then the stride permutation matrix RNSN PP ,
1
, =− . 

If N=RS, then the stride permutation matrix RN
T

SN PP ,, = . 

If N=RS, then the product between RNP , and SNP , becomes 

nSNRN IPP =⋅ ,, .    (3.15) 

Now, we state a theorem for the commutation of Kronecker factors using the previous 

stride permutations properties. 

Theorem 3.1 If A is a RR× matrix and B is an SS×  matrix then 

)()( 1
,, ABPBAP SNSN ⊗=⊗ − .           (3.16) 

 
Details of the stride permutations and proof of theorems and properties are 

described in [9]. In this chapter, we have presented basic concepts on Kronecker products 

algebra, which are used in the development of computing algorithms for digital signal 

processing. 

 

3.2 A Generalized Kronecker product 

In this section we will introduce a generalized matrix product [8],  which inherits 

some useful algebraic properties from the standard Kronecker products matrices.  
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Definition 3.1 Given a set of N )( rm×  matrices iA , i = 0, 1,…,N-1, denoted by NA}{ , 

and  an )( lN × matrix B, we define the )( rlmN× matrix )}({ BA N ⊗ as 

























⊗

⊗
⊗

=⊗

−− 11

11

00

}{

NN

N

bA

bA

bA

BA
M

 ,    (3.17) 

where ib  denotes the ith row vector of B. If each matrix iA is identical, then reduces to 

the usual Kronecker product of matrices.  

 

Example 3.1 

Let 
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The definition of 3.1 yields 
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which is recognized as a )44( ×  DFT matrix with the rows arranged in bit-reversed order. 

Definition 3.2 Let NA}{  be a sequence of N, )( nm×  matrices and E be a single 

)( rn× matrix.  

Then 
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where each matrix  in the sequence is )( rm× . From property (3.10) we know 

( ) ( ) ( )( )FEBAFBEA NNNN ⊗⊗=⊗ }{}{}{}{ .    (3.19) 

The next two identities are useful in developing sparse matrix factorizations. 

Identity 3.1 This identity yields a block-diagonal matrix containing the matrices iA . 
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i
NN AAAAIA L       (3.20) 

Identity 3.2 Now if we can express a R matrix as p sets of matrices denoted by
KN

kA }{ )( ,  

k = 0, 1,… p-1, where each matrix is  )( nm× , and the kth set has k
k mN = matrices. 

Consider the matrix R formed as  

)0()1()2()1( }{}{}{ 21 AAAAR
mm

p

m

p
pp ⊗⊗⊗⊗= −−

−−
L .  (3.21) 

The matrix R admits the sparse matrix factorization 
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Example 3.2 

For convenience, we show the identity m=n=2, p=3, as the identity can be established for 

other dimensions by following the same pattern of steps. 

Let )0(
2

)1(
4

)2( }{}{ AAAR ⊗⊗=  be written explicitly as  



  39  

   

[ ] )0()0(

1
12

3

2
2

1
02

1

2
0

)0(

1
1

1
0

2
3

2
2

2
1

2
0

ADA

A
A

A

A
A

A

A
A

A

A

A

A

A

R ⊗=⊗





















⊗












⊗












=⊗











⊗





















= ,     (3.23) 

where for convenience we have set  2
)1(

4
)2( }{}{ AAD ⊗= . Using equation (3.9) we 

have  

[ ] [ ] ))(( )0(
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Now, to solve for [ ] 2ID ⊗ , note from equation (3.20) that 
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we obtain the sparse matrix factorization 
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which agrees with (3.22) for m=n=2, p=3. 
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Identity 3.3 DFT matrices may also be expressed as  

{ } 1, 12/2/ =⊗= RRBR NNN ,   (3.27) 

and    1
2

,,1,0
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



−
= N

i
W

W
B

i
N

i
N

i L ,    (3.28)  

where Nj
N eW /2π−= . 

 

3.3 Filter Bank Structure 

 

 First a simple DFT filter bank [8]. 

)(
1

)( zaR
N

zh N= ,    (3.29) 

where NR  is an )( NN ×  DFT matrix, and )(za is a “delay” vector obtained as 

tNzzzza ]1[)( )1(21 −−−−= L .         (3.30) 

The word “delay” is used for )(za , as the term 1−z  denotes the backward delay operator. 

The utility of this filter bank in signal processing stems from a modest signal 

decorrelation property obtained at the filter bank outputs.  

The choice of NR as a DFT matrix in (3.29) is for handiness, since this choice also allows 

output samples obtained from the filter bank, to be interpreted as a Short Time Fourier 

Transform of a sliding window of the input samples. The elements 

1,,1,0),( −= NkzH k L  of   )(zh are shown in this case to satisfy 

.1,,2,1),()( 0 −== − NkzWHzH k
Nk L       (3.31) 
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Thus, the system can be understood as a bank of bandpass filters, where the 

frequency response of each band is frequency shifted of that of the adjacent band.  

Let us choose N=8 and derive two different realizations. Fist express from (3.27) 
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A flowgraph representation of the filter bank appears in Figure 3.1. 
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Figure 3.1 Simple DFT filter bank 
 
To obtain an alternative realization, observe that the delay vector can be factored as 
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replacing on (3.32) and using the definition 3.2  
 
 
 
                           
                                                                                                             .  
 
 
 
                 .   (3.35) 
 
 
we obtain 
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The correspond signal flowgraph appears on Figure 3.2.  
 

 
 

Figure 3.2 Equivalent DFT filter bank 
 
 
 

Figure 3.2 has more delay elements than Figure 3.1, but the computational 

requirements have been reduced. For transforms of larger dimension, this can represent a 



  44  

   

substantial saving in computational complexity. For example, with a larger N (taken to be 

a power of two), a direct implementation from equation (3.33) as Figure 3.1 would 

require (N-1) number of delays, and )(log)2/( 2 NN  number of butterflies. Whereas the 

equivalent realization from equation (3.36), as in Figure 3.2 would require 

)(log)2/( 2 NN  number of delays and (N-1) number of butterflies. 
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Chapter 4 

Sensor Array Structures 

 

 In this chapter we will present the problem of detecting signals using information 

from multiple sensors. The objective is to be able to understand the advantages of using a 

sensor array over a single element. Once we achieve this, we will learn about complex 

representation of the signals and DFT (Discrete Fourier Transform) for DOA (Detection 

of Arriving Angle), near and far wave fields, and signal to noise ratio (SNR) 

enhancement. Finally, a radar signal processing Toolbox for Matlab® (DBT 2.1®) shows 

an example of sensor arrays beamforming. 

 

In active sensing situations (e.g., radar and sonar), a known wave form of finite 

duration is generated, which in turn propagates through a medium, and is reflected by 

some target back to the point of origin. The transmitted signal is usually modified, both in 

amplitude and phase by the target characteristics, which by themselves might be 

changing with time and its position in space. For that reason, important digital signal 

processing theory, time-frequency representations and algorithms are implemented to 

obtain the information carried by the signal.  

 

4.1 Basic Concepts of Signal Complex Representation 

 

This chapter concentrates on the digital processing of plane sound waves arriving  
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at a passive sensor array. The structures of the receptor sensors are called unit 

dimensional array (ULA), and for our case, the study emphasizes in the linear array 

structures. The sensor and structure can be extended in quantity and dimension through 

the use of Kronecker array products. 

 

Changes in amplitude, direction and frequency can be modeled for signals far 

from the source, as a sinusoidal plane wave carrying an amount of energy, and 

propagating with a constant velocity away from the source [10]. A plane wave has some 

attributes such as amplitude, wavelength λ , temporal frequency cf , spatial frequency k, 

and propagation speed ν . A propagating plane wave can be sensed and modeled at a 

specific time and spatial point along a propagating direction, say the x-direction, using 

the following expression 

)(2
00

0),( kxtfj ceVxtS −= π .                     (4.1) 

 

4.1.2 Spatial Sampling of a Plane Wave 

 

 A plane wave can be spatially sampled, using an array of omnidirectional sensors, 

in order to extract information about its propagation direction and frequency content. 

 Features of a sensor array, such as number of sensors and distance between 

sensors, are related with the wavelength of the incident wave [11]. In our study case, a 

linear sensor array is utilized, and the sampling along the array can be represented as a 
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finite, discrete signal to be processed by the DSP processor. This signal along with linear 

sensor array axis at time t can be expressed as follows 

)sin(2

00

0
0

),(
θ

λ
π x

tfj c

eVxtS
−

= .                   (4.2) 

Figure 4.1 shows an incident plane wave at angle 0θ over a linear array of equally spaced 

sensor with separation distances d. 

 

 

Figure 4.1 Sensor Array Model for DSP implementation 

 

Then, considering the position of the sensor on the axis x, the signal can be expressed in 

terms of the position of the sensors changing x by –k.d for convenience as follows 
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In general, the signal kφ at the k-th sensor can be  

)
.

(2
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λ

π
φφ
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j

k e= ,    (4.4) 

where 00 sinθβ = . Spatial samples from all of linear sensor arrays can be expressed as an 

input vector T
N ].......,[)( 1100 −=Φ φφφβ , where )( 0βΦ  represents a monochromatic plane 

wave coming from 0β incidence direction. 

 

4.1.3 DFT for Direction of Arriving (DOA) Signal  

 

In the time domain this operation is performed using the time delay in order to 

obtain the coherent sum over the N sensors. The direction of the arriving signal is treated 

from the point of view of a linear transformation over a finite and discrete input signal. 

The DOA, is denoted as a row vector such that 000 )()( φββ NB =Φ , where 
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In general, the DOA, or commonly defined as beamforming vector, is used to steer an 

input vector )( 0βΦ , towards )( 0βB  direction obtaining as a result a beam pattern of a 

linear array steered to a specific direction of arriving. The product )()( 00 ββ ΦB  can be 

represented as  

∑
−
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−=Φ
1

0

2
0 )()(

N

k

kvj
k eB πφββ ,       (4.6) 
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where ( ) 0/ βλdv =  is called the spatial spectrum variable. The previous description can be 

extended to the formulation of multiple directions, in order to cover a discrete set of M 

angles along the entire set defined by )( πθπ <<−  or )11( <<− β . Multi-beamforming or 

multi angles detection can be formulated in terms of a matrix B in which rows represent 

linear transformations B )( kβ , for k = 0,1,…M-1, acting over a sampled data vector )(βΦ  

of length N as follows 
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Considering the case of M steering directions and N sensors, being M=N, a single 

linear transformation )( kB β can be written as 
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In (4.7), the steering angles are specifically chosen as ββ ∆⋅= kk , Nd/λβ =∆   and 

k={0,1,2,….,N-1}; NZk ∈ . That permits the redefinition of the equation (4.9) for multiple 

direction angles as a NN ×  matrix denoted by 
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where 







−
= N

k
j

k
N eW

π2

. Finally the multi-beamforming matrix B becomes the Discrete 

Fourier Transform (DFT) matrix. 

 
4.2 Signal to Noise ration advantage using an Array 

 

The possibility of modifying the array outputs to enhance the desired signal 

reception, and simultaneously suppress the undesired ones, can be illustrated by 

considering a single source situation as in Figure 4.1, in presence of N identical sensors 

[10]. Let Nddd ....., 21  represent the normalized distances of this sensors with respect to a 

reference point and )(0 tφ  the complex envelope of the signal at that point. On the other 

hand let )(),....,(),( 21 tntntn M  represent the respective noise components that are assumed 

in practice independent and identical process (in case of Gaussian distribution). This is 

evident with )(tkφ , representing the complex envelope of the total received signal at the 

k-th sensor, and using (4.4) 
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and the input signal-to-noise ratio (SNR) is 
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where 0P  represents the signal power received at sensor k=0. From (4.5) the signal 

components can be coherently combined, if the array output is phase shift by
02 β

λ
π kd

j
e

−
; 
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1,....,1,0 −= Nk and the resulting signals are added up. This gives the output signal y(t) to 

be  
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Thus a simple phase shifting and adding operation among the sensor outputs results in an 

improvement in the signal-to-noise ratio by a factor equal to the number of sensors N. 

 

4.3 Near and Far Waves Field 

 

Based on the distance away from the face of the source, where the radiated wave 

is measured, two important regions are identified. In the near field region the 

electromagnetic waves emitted from the source have spherical waveforms (equi-phase 

fronts). In the far field region, the wavefronts can be represented by plane waves [12]. 

We are interested in modeling the electromagnetic waves in the far field, taking the 

following criterion. Considering  Figure 4.2 where a radiating source at point O emits 

spherical waves. A receiving array of sensors of length d is at distance r away of the 

source.  
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Figure 4.2 Spherical front Wave and Plane front Wave difference. 

The phase difference between a spherical wave and a locally plane wave at the receiving 

array of sensors can be expressed in terms of the distance rδ . The distance rδ is given by 

the difference equation (4.13) 
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and since in the far field dT<<r, the equation (4.5) is approximated via binomial 

expansion by 
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It is customary to assume far field when the distance rδ corresponds to less than 1/16 of 

the wavelength. More precisely, if  
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168

2 λδ ≤=
r

d T
r

,       (4.15) 

then a useful expression for far field is 

λ

22 Td
r ≥ .     (4.16) 

Note that a far sound wave is a function of both the antenna size and the operating 

wavelength.  

 

4.4 Toolbox for Array Sensor Evaluation 

 

The main objective of this section, is the use of application DOA (detection of 

arriving angle) in radar and, the correspond computational implementation using a signal 

processing Matlab® Toolbox for radar DBT [13]. The Toolbox is especially suited for 

processing in the spatial dimension using signals from an antenna array. Both simulated 

and measured signals can be used. The objectives of DBT are to help us in the research 

on array processing; to perform these on measured radar signals that support cooperation 

in development of software tools, and to serve as a software demonstrator. DBT was 

under development at FOA (Defense Research Establishment of Sweden). 

 

4.4.1 Definition of the computational application using the DBT Toolbox 

 

We used this Toolbox to determine the number of sensors required when two 

signals arrive from two different positions. We want to learn about how many sensors we  
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need if the differences between arrive angles are far or close. This Toolbox help us to 

determine and simulate a possible model of sensor array characterized by the number of 

sensors, and the distance between sensors for determine signal to be received.  

  

4.4.2 How to use the Toolbox 

  

DBT is an extension of Matlab® programming language with data types and 

functions for signal processing in radar, especially antenna array processing. This 

constitutes a language on a higher level than standard Matlab® [13]. 

 

4.4.2.1 Sequence of Commands 

 A typical main program using DBT has the following sequence of commands, 

some of which can be omitted. 

• Definition of receiver antenna. 

• Acquire a signal, simulated or measured. 

• Calibration compensation of signal or set the compensation method to be used. 

• Conventional processing. 

• Select data for model based processing. 

• Estimate and modify a spatial correlation matrix. 

• Model based detection and estimation. 

• Present the result. 

An example program with a (unit dimensional array) ULA antenna with distance  
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d  = 0.45*λ, where  λ represent the wave length, and two signals at o321 =θ and o402 =θ . 

The output plot is based on the number of sensors to be used for correct discrimination 

between this two (direction of arrive) DOA. A basic step for running this example is 

shown on  Figure 4.3. 

 

 

 Figure 4.3 Programming steps for Beamforming using DBT Toolbox [13]. 

 

Figure 4.4 shows the output beam for an array of six sensors. We only observe a main 

lobule with the maximum at 34° , but the two original signals has 32° and 40° degree of 

angle incidence. Figure 4.5 shows the output beam for an array of twelve sensors, where 

we only see a main lobule with the maximum at 33° , but the two original signals has 32° 

and 40° degree of angle incidence. Figure 4.6 shows the output beam for an array of 

twenty-four sensors, where we detect two lobules with the maximum at 32°and 40°, but 

the resolution is not enough, they are mixed. 
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Figure 4.4 Output beam using a six sensor array. 

 

 

Figure 4.5 Output beam using a twelve sensor array. 
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Figure 4.6 Output beam using a twenty-four sensor array. 
 

 

Figure 4.7 shows the output beam for an array of forty-eight sensors; where we can 

observe two lobules with the maximum at 32°and 40° with good resolution. 

 

Figure 4.7 Output beam using a forty-eight sensor array. 
 

Finally on Appendix B all Matlab® code to run this example is shown. 
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Chapter 5 

Time-Frequency (TF) Representations 

 

In the real world it is not common to find stationary signals. For that reason a 

joint representation TF, of this kind of signals, are more efficient than time or frequency 

domain representations alone. The disadvantage of joint this representation TF is 

computationally intensive, because the algorithms developed are more complex to map 

from time domain into the joint TF representation [14]. Nowadays with the development 

of new powerful digital signal processors the real time could be reached. The following 

real implementations based on short time Fourier Transform and Ambiguity function will 

be explained on this chapter. 

 

5.1 Short Time Fourier Transform (STFT) 
 

 

The theoretical key that describes computing spectra over finite time intervals is 

the STFT. Calculating this quantity means that we apply to a signal at time n a window of 

duration M (window-points), then evaluate the Fourier Transform of the product: 

∑
∞

−∞=

−−=
m

mk
Mk WmxmnhnX )()(][ .            (5.1) 

Here h(n-m) denotes the finite window defined over [0,M] . The window duration defines 

the frequency resolution of the short-time Fourier analysis, because knX ][ equals to 
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Fourier Transform of the product between the sensor signal )(mx  and the original 

window at n, the signal’s spectrum is smoothed by the window’s spectrum [15]. 

From (5.1) we can define STFT as follows 

])()[(][ ∑
∞

−∞=

−−=
m

mk
Mk WmxmnhnX  

)(])([][ mhWmxnX mk
Mk ∗= −           (5.2)  

where mk
MW− represent M

kmj

e
π2−

, ∗  represent convolution and the product 

])([ mk
MWmx − represent the modulation of  )(mx with 

M

k
k

πω 2= . The last equation (5.2) 

defines the filter method to compute the STFT [16] as shown in  Figure 5.1 

 

 

Figure 5.1 Filter method to compute STFT 

 

Figure 5.2 shows h(m) as a Hanning window of 256 points, and x(m) as a chirp signal 

with two seconds of duration and  frequency 0-500Hz. The result of the STFT Figure 5.3 

shows the spectral content of the chirp signal at different intervals of time with step size 

of 126 points. The filter method has a deficient when low frequencies want to be detected 

because the first window does not overlap. 
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Figure 5.2 Hanning window 256 points and Chirp Signal two seconds 0-500Hz 
 

 
 

Figure 5.3 STFT belongs to Chirp signal. 
 

Figure 5.4 shows a more realistic application of STFT using a trumpet sound with six 

seconds of duration, we can observe a main frequency next to 1500Hz and different 

harmonics separated 500Hz, here we observe the 2D and 3D representation of STFT. 
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Figure 5.4 2D and 3D STFT that belongs to trumpet sound.  

 
 
5.2 Ambiguity Function (AF) 
 

Another way to compute join TF is based in the Fourier Transform of cross 

correlation between transmitted signal and received signal. The name of this function 

Ambiguity, explains if a poor correlation was found, if the ambiguity between that two 

signals is high, and vice versa, if the correlation is high, the ambiguity is poor between 

transmitted and received signal. The AF evaluates the Fourier Transform of the product 

   

∑
−

=

Π−∗ +=
1

0

2

][][],)[,(
N

n

N

knj

N
rr emnSnSkmSSA αα , 

let 

][[][;
N

rmr mnSnS += ∗∗
,        (5.3) 

then 
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][][][ ;; nSnSnS mrmw
∗= α ,        (5.4) 

∑
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; ][],)[,(
N

n

N

knj

mwr enSkmSSA α .         (5.5) 

Where αS and rS are transmitted and received signal respectively, m means the index for 

move in object space, k means frequency spectral shift. ][; nS mr
∗  means a family of 

received signals with different time shifting m and this shift are cyclic (5.3). ][; nS mw  

means a signal family of windows equal to Hadamard product between ][nSα transmitted 

signal and ][; nS mr
∗  the family conjugate of received signals shift in time for each m (5.4). 

Finally (5.5) shows the Fourier Transform of each signal family’s window ][; nS mw . 

Equation (5.5) also shows, the Fourier Transform of multiplication of two signals that 

means the correlation of the spectral signal multiplied. The last method to compute the 

AF is called Frequency Correlation. Figure 5.5 shows the 3-D plot of the AF versus 

frequency and time delay. The AF is normally used by radar designers to study different 

waveforms. In this example we simulate a chirp signal transmitted and received for a 

bandwidth of 3Khz, and the difference between time and frequency is plotted using 

Matlab®. The algorithms to compute this AF are implemented on of the TMS320C6711 

DSP. 
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Figure 5.5. AF  for Tx and Rx Chirp signal. 
 

5.3 Time-Frequency Hardware Implementation using the DSK320C6711 

 

 In order to use a real DSP processor for TF representations, we implemented the 

STFT and the AF for different signals size on the TMS320C6711 of T.I. and the Code 

Composer Studio CCS v2.1. These implementations are used to compute the capability of 

processing and storage of the DSP processors, using double precision variables (64-bits) 

[14]. We will determine the capabilities of this DSP processor using the time of 

execution, size of the signal processed and memory consumption; these results will be 

summarized on Table 1and Table 2. For next sections the STFT and the AF will be 

implemented. 

 

 

 



  64  

   

5.3.1 Short Time Frequency Transform (STFT) implementation on the 

    TMS320C6711 

 For implement this function we will use the following routines implemented using 

the Code Composer Studio CCS v.2.1 and C language. This algorithm is a modification 

of the equations explained before using the FFT method for cascade of filters bank. 

/* Main program */ 
void main() 
{  
Input_signal_Padding((double*) X);      // Data input padding to M+L-1 
Matrix_modulation((double*) x_padd);  //Data input chirp modulated 
FFT_TI();      // fft of rows 
Haddamart ((double*) h);              // haddamart product with the fft(filter) 
In_FFT_TI();              // Inverse fft 
}.   
 

5.3.1.1 Short Time Frequency Transform (STFT)  for N filters bank x 1024 

Signal points 

 

For hardware implementation we simulated a Chirp signal (897-points) using 

Maltlab®, as shown in Figure 5.6a) and the filter window Figure 5.6 b) correspond a 

Hanning window (128-points). The computation of the STFT using the filter bank 

method is performed using the TMS320C6711 processor. Figure 5.7a) represents a STFT 

of 8 filter banks, Figure 5.7b) represent a STFT of 16 filters bank, Figure 5.7c) represent 

a STFT of 32 filters bank, Figure 5.7d) represent a STFT of 64, Figure 5.7e) represent a 

STFT of 128 filters bank filters bank, Figure 5.7f) represent a STFT of 256 filters bank, 

Figure 5.7g) represent a STFT of 512 filters bank,  Figure 5.7h) represent the maximum 

STFT implemented on the DSP320C6711 a STFT of 1020 filters bank. All the last filters 

banks had an output matrix N-filter by 1024 points with double precision variables. 
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a)          b) 

Figure 5.6. Signals to implement the STFT a)Linear Chirp, b) Hanning window filter 

 

 

 

     

 

 

a) b) 

     

 

   

 

 

  

b) d) 
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e)             f) 

   

g) h) 

Figure 5.7. STFT for Chirp Signal of 924 points and different quantity of Filters Banks 

         

5.3.1.2 Short Time Fourier Tranform (STFT) Time Implementations 

 

The table 1 shows the summary of signal points for the Chirp signal, the matrix 

points for the STFT, the Twiddle Factors spend to compute the FFT , the time 

consumption of STFT and finally the memory spent in bytes. 
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STFT Execution Times 
  

SIGNAL POINTS MATRIX POINTS Twiddle Factors AF Time sec External Memory Consuption Bytes 

897 8 x 1024 512 15 sec 131072  

897 16 x 1024 512 31 sec  262144 

897 32 x 1024 512 62 sec  524288 

897 64 x 1024 512 126 sec 1048576  

897 128 x 1024 512 252 sec 2097152  

897 256x 1024 512 508 sec 4194304 

897 512 x 1024 512 1024 sec 8388608 

897 1020 x 1024 512 -out-time- 16711680 

 

Table 1.  Summary of STFT implementations on the DSP320C6711 

 

5.3.2 Ambiguity Function (AF) implementation on the TMS320C6711 

 

 To implement this function we will use the following routines implemented using the 

Code Composer Studio CCS v.2.1 and C language: 

/* Main program */ 
void main() 
{  
Corr(Sigtx, Sigrx );             // Cross Correlation. 
Shift_Signal (Sigrx);          // Matrix of ciclyc shifth received signal. Equation (5.3) 
Haddamart (Sigtx);           // Matrix  of Haddamart product with the transmitted signal. 
             Equation (5.4) 
  
Complex_Complement(); // Complex part introduced to the Matrix 
 
FFT_TI();                        // FFT of the Matrix’s Rows . Equation (5.5) 
}. 
 
 
5.3.2.1 Ambiguity Function (AF) for 256x256 points 

 

For a real implementation we simulated using Maltlab® a Chirp signal (256-

points) for transmition and the delayed reception signal as used on radar applications. The 
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computation of the Cross-Correlation and the AF is performed on the TMS320C6711 

processor. Figure 5.8a) represent a 256 points transmitted (Tx) chirp signal. Figure 5.8b) 

represent a 256 received (Rx) chirp signal. Figures 5.8c) and 5.8d) represent the power 

spectrum of the Tx and Rx signal. Figure 5.8e) shows the Cross–Correlation between Tx 

and Rx signal. Finally Figure 5.8f) represent the AF matrix 256x256 where time and 

frequency maximum represent the difference in time and frequency between the Tx and 

Rx signal. 

 

 

 

 

 

    

 

a) b) 

 

 
 
 
 
 
 
 
 
 
 

c) d) 
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e)            f) 
 

Figure 5.8 Time frequency representation of  256 Tx and Rx Chirp Signal. 
 
 

 5.3.2.2 Ambiguity Function (AF) for 512x512 points 

 

For a real implementation we simulated using Maltlab® a Chirp signal (512-

points) for transmition and the delayed reception signal as used on radar applications. The 

computation of the Cross-Correlation and the AF is performed on the TMS320C6711 

processor. Figure 5.7a) represent a 512 points transmitted (Tx) chirp signal. Figure 5.7b) 

represent a 512 received (Rx) chirp signal. Figures 5.7c) and 5.7d) represent the power 

spectrum of the Tx and Rx signal. Figure 5.7e) shows the Cross–Correlation between Tx 

and Rx signal. Finally Figure 5.7f) represent the AF matrix 512x512 where time and 

frequency maximum represent the difference in time and frequency between the Tx and 

Rx signal. 
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a) b) 
 

 
 
 
 
 
 
 
 
 
 
 
 
   c)          d) 
 
 
 
 
 
  
 
  
 
 
 
 
 

d) f) 
 

 
Figure 5.7 Time frequency representation of  512 Tx and Rx Chirp Signal. 
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5.3.2.3 Ambiguity Function (AF) for 1020x1024 points 

 

For a real implementation we simulated using Maltlab® a Chirp signal (1024-

points) for transmition and the delayed reception signal as used on radar applications. The 

computation of the Cross-Correlation and the AF is performed on the TMS320C6711 

processor. Figure 5.8a) represent a 512 points transmitted (Tx) chirp signal.  Figure 5.8b) 

represent a 512 received (Rx) chirp signal. Figures 5.8c) and 5.8d) represent the power 

spectrum of the Tx and Rx signal. Figure 5.8e) shows the Cross–Correlation between Tx 

and Rx signal. Finally Figure 5.8f) represent the AF matrix 1020x1024 where time and 

frequency maximum represent the difference in time and frequency between the Tx and 

Rx signal. This is the maximum capability of storage next to 16-Mbytes. 

 

 
 
 
 
 
 
   
 
 
 
  
 a)           b) 
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   c)           d) 
 
 
 
 
 
 
 
 
 
 
 
  

e) e) 
 

Figure 5.8 Time frequency representation of  1024 Tx and Rx Chirp Signal. 
 
 

 

5.3.2.4 Ambiguity Function (AF) Time Implementations 

  

 The Table 2., shows the summary of signal points for the Tx signal and Rx, the 

matrix points for the AF, the Twiddle Factors spend to compute the FFT , the time 
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consumption for the Cross-Correlation, the time consumption of AF and finally the 

memory spent in bytes. 

 
 

      Ambiguity Function Times     

SIGNAL POINTS MATRIX POINTS Twiddle Factors Cross-Correlation Time sec AF Time sec External Memory Consumption Bytes 

256 256 x 256 128 0.217 5.8 1048576 

512 512 x 512 256 0.871 20  4194304 

1024 1020x1024 512 3.502 80  16777216 
 

 
Table 2.  Summary of AF implementations on the DSP320C6711 

 
 

Finally on Appendix C, the routines for STFT and AF are shown in C programation 

language.  
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Chapter 6 

Multirate Sensor Array  System based on Kronecker Products 

 

This chapter shows the implementation of multirate concepts (down-sampling) 

using sensor arrays on digital signal processor (DSP) units such as TMS320C6711 DSK. 

This implementation based on Kronecker products formulation for mapping from 

hardware configurations to software algorithms, centers on a scalable and modular 

approach. The scalable approach to this implementation implies that the function and 

structure of each algorithmic formulation should adapt to changes in the size of the sensor 

array and on the length and dimensions of the signal to be processed. The modularity 

approach implies that each system can be composed by a set of modules with flexible 

interconnectivity, and reconfigurability will be obtained. 

 

6.1 Computational Sensor Array System 

 

 When individual sensors are placed in a regular grid as shown in Figure 6.1, this 

produces a sample array aperture of the received sound signal (6.1): 

 

[ ])()....()()( 110 tStStStS rNrrr −= ,                (6.1) 

 

where N means the number of sensors. The row vector of information )(tSrK , stores the 

intensity of the front sound wave at different instants t, transducer from the respectively 

microphone through the A/D converter. For a specific time t we obtain a row vector of 
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information corresponding of space sampling difference distances d. For last 

considerations, let us work in terms of vectors and matrixes to introduce the Kronecker 

products, in order to develop algorithms for computational structures such as DSP 

processors. Other important consideration when we use array of sensors consists in the 

improvement of the SNR, as demonstrated in (4.12). The original 0)(SNR  is enhanced by 

the number of sensors N. 

 
Figure 6.1 Computational Sensor Array System  

The computational sensor array system Figure 6.1 consists on the initial concept 

to develop a physical implementation using a six-sensor array of microphones (Appendix 

F. for tools utilized). After that, a six-channels A/D converter, and then a DSP processor 

receive all the digitalized six-channels signals and perform different signal processing 

operations such as Discrete Fourier Transform (DFT) for spectral analysis, Short Time 
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Frequency Tranform (STFT) for time-frequency representations, Ambiguity Function 

(AF) for radar applications, Filter and Convolution for signal analysis. Then a PC 

interface for final storage, and output plots using Matlab®. 

 In this Chapter we will implement a physical Beamforming application defined 

for detecting the direction of arriving (DOA) signal to an array of sensors. The following 

sections explain a block diagram for the actual implementation of this system. 

 

6.1.1 Data Acquisition Configuration 

 

This system, Figure 6.2, assumes a sound wave arriving to the unit linear array 

(ULA) of sensors with defined distance d. After that, the signal conditioner circuit put the 

correct offset voltages to the A/D daughter card, then the digitalized signals are obtained 

for the DSK320C6711 microprocessor, and finally an output file.h is stored on PC to be 

read for Matlab® and plot [15]. 
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Figure 6.2 Computational Unit Linear Array (ULA) sensor system.  
 

6.1.2 Data Acquisition Implementation 

 

Figure 6.3 shows the physical implementation of unit dimensional array (ULA) 

using six microphones 6.3a), six analogs inputs 6.3b), a signal conditioner circuit 6.3c), 

the daughter card ADS8364 with 6 A/D converters and the DSK320C6711 

microcontroller 6.3d). 
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b) Analog Data Input 6ch            a) Unit Dimensional Linear Array 
 
 
 
 
 
 
 
 
 
 
 
 
 
    
 
 
 c)  Signal Conditioner AIP-0404-01    d) A/D and DSK-MICROPROCESSOR 
 

 
Figure 6.3 Physical computational implementation of unit dimensional array 

(ULA) 
 

6.1.3 Six channels A/D of sine wave sound 

 

This is a probe sound signal to determine the functionality of the unit dimensional 

array (ULA) system implemented using the configuration of Figure 6.3. The A/D 

ADS8364 DSK320C6711 
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converter ADS8364 of Texas Instruments offers 6 channels (A0, A1, B0, B1, C0, C1) of 

analog to digital conversion, Figure 6.4 shows the six channels sampling at 128Ksps and 

256 points, the six channels perform the sampling at the same time, and the storage data 

of each channel was plotted using a Matlab® as visual interface Figure 6.4a), and Beam 

pattern Figure 6.4b).   

 
 
 
 
 
 
 
 
 
 
 

 
 

a) Output plot from 6 channels, 128Ksps, 256 points 
 

 

 

 

 

 

 

 

 

 

b) Output detected for conventional Beamforming 

 

Figure 6.4 Six-sensor array Beam forming  
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6.2 Kronecker products for Multirate Sensor Array Beamforming  

 

Beamforming is a signal processing operation used widely in wireless 

Communication, Radar, and Sound applications to estimate the DOA of a propagating 

waveform source when the waveform is received by an array of sensors [19]. 

When the input array sensors grown to large scale implementations a partial 

Beamforming is performed decomposing the input vector x of length L=NM in M 

segments of length N, as  

 

                                                                      .      (6.1) 

Thus, we define a Kronecker parallel factor as a diagonal matrix 

 

 

 

 

                                                                                    .                                        (6.2) 

 

Multi-Beamforming is performed collecting and combining the output information, 

channel by channel, of every DFT, on this process the increasing factor of SNR is 

obtained as demonstrated in equation (4.12). Thus, we obtain a matrix of size NM  

 

 

  

  

                                                                                                                   .     (6.3) 

 

The mathematical formulation using Kronecker products for the multi-beamforming 

(MB) operation becomes  

( ) xIF MN ⋅⊗



  81  

   

               

                                                                                                               ,   (6.4)                                  

 

where [�S] means the down sampling process performed by the Multirate block. Figure 

6.5 shows the implementations of the last formulations. The specific block of Multirate 

pre-processing is shown on Figure 6.6, where the product xS].[↓  is implemented. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 6.5 Kronecker Multirate Beamforming implementation blocks. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

( ) ( ) xSIFUIMB MN
T
MN ⋅↓⋅⊗⋅⊗= ][
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Figure 6.6 Block diagram of Multirate Pre-processing 

 

6.3 Multirate Beamforming with 32 Sensors Array using Kronecker products 

      and implemented on the DSK320C6711 processor. 

 

 The implementation of the Beamforming using 32 sensors array (ULA) Figure 

6.7, is based on the concepts explained in the section 6.2. The large scale implementation 

of sensors, in this case 32 sensors, cannot be physical implemented using an array of 

microphones. For that reason, we simulated the incoming data from 32 sensors using 

Matlab® and stored on the DSK320C6711 to perform real computation of the 

Beamforming. The computation performed by the DSP processor, the output matrix B 

stored on the memory of the DSK320C6711 is translated then to the PC and the output 

Beamforming could be plot using Matlab® as visual interface.  
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Figure 6.7 Kronecker Multirate Beamforming implementation using 32 Sensors Array 

 

 Figure 6.8 shows the output plot of the Beamforming for 32 sensors array without 

down sampling or S=0, the number of samples vectors are 256 each one with 32 

positions to built an input matrix of 256x32, then each input vector (32 positions) is 

divided in 4 modules of 8 sensors to perform the 8-points Discrete Fourier Transform 

(DFT) and finally a coherent sum for partial beams. The dimensions of the output matrix 

B is 256x8 , the plot of each entire column (256-length) of this matrix represent each of 

the beams (8 in total) detected as shown in Figure 6.8.  
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Figure 6.8 Beam Pattern Detected without down sampling, S=0. 

 

 The output means that the detected beams had to be of incidence angle with 

respect of sensor array such as 0°, 15°,30°, 45°,90°, 135°,150°, 165°.To diminish the 

computational effort we can use a down sampling by 2=S  in order to reduce the input 

sample vectors from 256 to 128, each one with 32 positions to built an input matrix of 

128x32, then each input vector (32 positions) is divided in 4 modules of 8 sensors to 

perform the 8-points Discrete Fourier Transform (DFT) and finally a coherent sum for 

partial beams. The dimensions of the output matrix B are 128x8. The plot of each entire 

column (128-length) of this matrix represent each of the beams (8 in total) detected as 

shown in Figure 6.9.  
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Figure 6.9 Beam Pattern Detected with down sampling, S=2. 

  

 The output means that the detected beams had to be of incidence angle with 

respect of sensor array such as 0°, 15°,30°, 45°,90°, 135°,150°or 165°. This output 

shows the same incidence angles as Figure 6.7. Both plots, Figure 6.7 and Figure 6.8 

have the same amplitude )(chY  and the same angles detected, for that reason the down 

sampling process offers a way to reduce computation time without extremely final 

resolution affected of the Beamforming system. Figure 6.10 and 6.11 plot the output 

beam using a down sampling factor S=4, and S=8.  
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Figure 6.10 Beam Pattern Detected with down sampling, S=4. 

 

 

 

 

 

 

  
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.11 Beam Pattern Detected with down sampling, S=8. 
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 Table 3 shows the different time of execution for down sampling reduction by S=0,2,4,8 

and different size of the input matrix. 

 
Table 3.  Execution Times for 32 Sensor Array  with S=0,2,4,8 Down samples 

 
 
 

Finally, Appendix D shows the algorithm used to compute the Beamforming application 

on the TMS320C671 DSP processor. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Beamforming Time of Execution 
 

SENSOR ARRAY 
S INPUT 

MATRIX  L = M*N 
CLOCK 

PERIODS BF TIME sec 
32 0 256x32 8*4 214007410    0.214 
32 2 128 x 32 8*4 107001190    0.107 
32 4 64 X 32 8*4 53482606    0.053 
32 8 32 X 32 8*4 26741810    0.027 
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Chapter 7 

Conclusions and Future Work 

7.1 Conclusions 

 

This work presented  Kronecker Structures for Multirate Sensor Array signal 

processing systems. The concepts of Multirate and Sensor array were studied to be 

implemented on an actual DSP floating point processor TMS320C6711 from T.I. The 

mathematical framework of this work is based on Kronecker products that shown an 

important tool to develop and implement modularity and scalability hardware and 

software on signal processing systems.    

The hardware and software tools utilized on this work offered a practical way to 

evaluate the maximum capabilities of the first floating point (32 bits) DSP processor 

TMS320C6711 from T.I. in the field of Multirate, Sensor Array and Time-Frequency 

representations. Tables 1, 2, and 3 summarized the maximum capabilities on memory and 

time execution utilized by the DSP processor. The DBT tool box for Matlab® offers an 

interesting approach in the field of Radar applications and sensor array system to use 

Matlab® as a developed environment.       

 The scalability and modularity approach based on Kronecker products to 

formulate software and hardware implementations in the field of Sensor Array shown a 

useful tool, because the quantity and configurability of Unit Linear Arrays (ULA) sensors 

could be changed for specific applications or possible external damage of sensors, 

without change DSP routines.  
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 A complete hardware and software physical implementation using an array of six-

microphones was performed with the six channels, 16bits A/D converter, ADS8364 

evaluation module of T.I. and the AIP-0404-1 conditioner signal. In order to probe the 

concepts for a  realistic application, a 32 sensor array signal was simulated using 

Matlab®, and the total evaluation was performed on the DSP to obtain an 8 

Beamforming plot. To reduce execution time, a Down-sampling processing was 

implemented to reduce the data computational effort, Table 3.  

 Different time-frequency algorithms such as Short Time Fourier Transform 

(STFT) and Ambiguity Function (AF) for complete characterization of Chirp (Radar) 

signals were implemented using C language and double precision variables (64-bits) for 

code execution and storage respectively. In order to understand the advantages and 

disadvantages of this implementation, different long of signals were utilized and the 

Tables 1 and 2, showed the maximum capability for storage and output matrixes, 

obtained with the last transforms.   

 The floating point architecture of the DSP processor TMS320C6711, offers a new 

broadband field for applications were computational accuracy is required. This was the 

case of the STFT, AF and, Cyclic Correlation algorithms. The rising number of bits 

utilized from Analog to Digital converter opens the possibility to conjugate embedded 

DSP processors with enough computational power and the accuracy required for 

specialized applications on signal processing. 
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7.2 Future Work 

 

 In order to compute actual applications using DSP processor, increasing the 

number of sensors for high scale implementations on Multirate Sensor Array Systems, a 

multi-DSP processor boards can be studied to obtain a higher computational and memory 

resource for real time applications in the field of Time frequency representations, and 

Sensor Array processing. 

 

 The rising embedded applications on digital signal processing and sensor array 

systems open the development possibility of new applications in the field of Power 

Quality, Automotive Control and, Sound Systems, using well known signal processing 

techniques. This is because some years ago the computational requirements, the 

algorithm complexity and A/D’s resolution, were not efficient.  
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A. User Guide to Multirate System 

 

Introduction  

This project consists in the utilization of the TSM320C6711 DSP processor and 

the PCM3003 audio daughter card to implement multi-rate system.  The project consists 

of a fractional rate change by 2/3 and 3/2 samples from the input signal.  Based on the 

concepts of up-sampling, down-sampling and FIR (Finite Impulse Response) filters, we 

are going to develop the following processes which are the base of a Multi-rate system. 

System Flow Chart 

 

 

9. Input signal:  Generator, microphone or music with maximum frequency of 

4KHz. 

1. A/D 
Fs=36KHz/24KHz 

DSP 
Processor 

2. 
Record 
Memory 

8sec 

3. 
Read 
From 
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4. 
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sampling 
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5. 
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Fc={pi/3} 

7. 
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by L 

8. 
D/A 

Fs=24KHz
/36KHz 

 input signal 

 output signal 

6. 
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Sampled 
array 

Control      
Data flow 
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10. A/D converter: Sampler input signal at a rate of 36KHz or 24KHz. 

11. Record Memory:  It stores the sampled signal into a buffer array of size 36Ksps or 

24Ksps * 8sec. 

12. Read from Memory:  With a pointer we are able to recover the samples stored in 

the buffer memory. 

13. Up-sampling by M:  introduces (M-1) zeros between each sample read from the 

buffer-memory. 

14. LPF:  It removes spectral images, interpolates and limits frequency for the down-

sampling stage. 

15. Down-sampling by L:  Reads every L sample from the output memory. 

16. D/A converter:  it converts from digital to analog with a sampling rate of 24 KHz 

or 36 KHz. 

The output signal is going to be reproduced with the same frequency as the original if the 

D/A converter operates at frequency 24 KHz or 36KHz.  This is obtained from the 

following relation: KHz
KHz

Fsout 24
3

2*36 == .  KHz
KHz

Fsout 36
2

3*24 ==  

We are going to implement all of the above mentioned stages in the DSP board and the 

Code Composer Studio development software. 

 

Hardware Settings 

 

1.  The DSK board, TMS 320c6711, should be connected to the computer through the 

parallel port and be connected to the power supply. 
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2.  The DSK board should have installed the Audio Daughter Card, PCM3003, for this 

particular project.  The Audio Daughter Card should be installed on the DSK according 

to the instruction of the manufacturer. 

 

3.  The Audio Daughter Card should have the following jumper configuration: 

 JP1, JP2, JP4, JP9, JP10 disabled 

 JP3 connection from the Audio Daughter Card with the DSK. 

 JP5 MCLK short pins 1 and 2. 

 JP6 FSCTRL short pins 3 and 4. 

 JP7 DGND short pins 1 and 2. 

 JP8 DVDD short pins 1 and 2. 

 JP11 BITRATE short pins 5 and 6. 

 JP12 SAMPLERATE short pins 3 and 4. 

Note: 

The jumper configuration depends on the square solder on the bottom side of the Audio 

Daughter Card.  It should be noted that the pin #1 is the square solder.  The complete 

jumper configuration is illustrated in Figure 1.  
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Figure 1 Audio Daughter Card jumper configuration. 

 

4.  The project uses standard stereo plugs with both right and left channels connected to 

the Audio Daughter Card. 

 

Project Creation 

 

There are two ways to create the Multirate project from an acquired file. 

 

Fast and Easy Way: 

1.  Select the given folder named Mulirate and save it on the following path: 

 c:\ti\myprojects\ 

the final path to the stored file is:  

 c:\ti\myprojects\Multirate 

 



  98  

   

2.  Open the CCS and Select Project => Open Project  and search for the Multirate folder 

and open it.  Then choose the file: Multirate.pjt and open it. 

 

3.  Now jump to the section: Building and Running the Project for building and 

running the Multirate project. 

 

Step by step project creation 

 

1.  To create the project file Multirate.pjt. Select Project => New. Type Multirate for 

project name as shown in figure 2a. This project file is saved in Multirate (the folder you 

created in c:\ti\myprojects).  The .pjt file stores project information on build options, 

source file names, and dependencies. 

 

2.  To add files to project. Select Project => Add files to Project.  Look in Multirate.  

Files of type C Source Files.  Open the C sources files Filter.c , interrupts.c , mcbsp1.c , 

Miltirate System.c , stereo.c and, switches.c.  Open (to add to project) one file at a time;  

or place the cursor to one of these files, then to the other while holding the Shift key, and 

press Open.  Click on the “+” symbol on the left of the Project Files window within CCS 

to expand and verify that the C sources files have been added to the project. 

 

3.  Select Project => Add Files to Project.  Look in Multirate.  Use the pulldown menu 

for Files of type: and select ASM Source Files.  Double-click on the assembly source file 

vectors.asm to open/add it to the project. 
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4.  Repeat step 3 but select Files of type: Linker Command File, and add the linker 

command file lnk.cmd  to the project.   

 

5.  Verify that the linker command (.cmd) file, the project (.pjt) file, the C (.c) files, and 

the assembly (.asm) files have been added to the project. 

 

6.  Note that there are no “includes” files yet.  Select Project => Scan All Dependencies.  

This add/includes the headers files:  c6211dsk.h , COEF_CLPF.h , interrupts. , mcbsp1.h, 

stereo.h , switches.h , and c6x.h.  The last one is included in the CCS files, the others 

have to be copied (transferred) from the accompanying disk supplied by us. finally the 

figure 2b shows all the included files of this project.  

 

Compiler Option:  Select Project => Build Options.  Figure 3 shows CCS window 

Build Options for the compiler.  Look at the figure and fill with the exact values 

presented at the Figure 3a. 

 

Linker Option:  Click on Linker (from CCS Build Options) and select Absolute 

Executable (for Output Module), Multirate.out (for Output Filename), and Run-time 

Autoinitialization (for Autoinit Model).  The output filename defaults to the name of the 

.pjt filename.  The linker option should be displayed as in Figure 3b.   
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(a) 

 

(b) 

Figure 2 CCS Project View window for Multiraet: (a) creating project; (b) project files 
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(a) 

 

(b) 

Figure 3 CCS Build options: (a) compiler; (b) linker 
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Building and Running the Project 

 

The project Multirate can now be built and run. 

1.  Build this project as Multirate.  Select Project => Rebuild All.  Or press the toolbar 

with the three down arrows.  This compiles and assembles all the C files and assembles 

the assembly file vectors.asm.  If the compilation was successful, the executable file 

Multirate.out is created that can be loaded into the C6711 processor and run.  Note that 

the commands for compiling, assembling, and linking are performed with the Build 

option.  Figure 4 shows several windows within CSS for the project Multirate.   

 

Figure 4  Windows for project Multirate.pjt 
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2.  Select Debug => Reset CPU in order to clear and initialize all the registers on the 

DSK.  Then Select File => Load Program in order to load Multirate.out by clicking on it.  

It should be in the project Multirate folder.  Connect an input signal from the signal 

generator or audio source to the IN connector ( j1 ) on the Daughter Board of the DSK, 

also connect a speaker and the oscilloscope to the OUT connector ( j2 ) on the Daughter 

Board of the DSK.  This prepares the Multirate implementation on the DSK for use. 

 

NOTE:  Before the Run command on the CCS, the user should put all the user switches 

on the DSK to zero, or to the down position.  Depending on the multi-rate desired, the 

user may select switches (USER_SW1) = ‘1’, (USER_SW2) = ‘0’ and (USER_SW3) = 

‘0’ for 2/3 rate, Fs(in) = 36 KHz and Fs(out) = 24 KHz.  Or select switches (USER_SW1) 

= ‘0’, (USER_SW2) = ‘1’ and (USER_SW3) = ‘0’ for 3/2 rate, Fs(in) = 24 KHz and 

Fs(out) = 36 KHz .  If the program is run with the switch = 0 the rate will be selected as 

default as 2/3 and Fs = 24 KHz. 

 

3.  Select Debug => Run.  Or use the toolbar with the “running man”.  Now track the 

following routine for the switches in the DSK to run the Multi-rate system.  It should be 

noted that the User Selectable Switches represent a 3 Bits binary number where the LSB, 

(Lowest Significant Bit), is the switch (USER_SW1), and the MSB, (Maximum 

Significant Bit), is the switch (USER_SW3). 
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Follow the next steps and compare them with the Figure 5 . 

 

 a. Select switches (USER_SW1) = ‘0’, (USER_SW2) = ‘0’ and (USER_SW3) = 

 ‘0’  for “Straight through, no recording” state.  This switch value correspond 

 to the “0” value in decimal base.  This routine loops back the input signal to the 

 output of the DSK Daughter board.   

 b. Select switches (USER_SW1) = ‘1’, (USER_SW2) = ‘0’ and (USER_SW3) = 

 ‘0’ for “Manual recording in progress” state.  This switch value correspond 

 to the “1” value in decimal base.  This routine takes the digital out of the ADC 

 and stores it on the RAM memory, called “record_array”, on the DSK.  Wait  with 

 the switch in that state until the message “Buffer Full” appears in the Stdout 

 window on the CCS. 

 c. Select switches (USER_SW1) = ‘0’, (USER_SW2) = ‘0’ and (USER_SW3) = 

 ‘0’ to return to the “Straight through, no recording” state.   

 d. Select switches (USER_SW1) = ‘1’, (USER_SW2) = ‘1’ and (USER_SW3) = 

 ‘0’ for “Normal playback” state.  This switch value correspond to the “3”  value 

 in decimal base.  This routine plays back the recorded sound from the memory, 

 “record_array”, of the DSK at the same Sampling Frequency as the input 

 sampling rate. 

  e. Select switches (USER_SW1) = ‘0’, (USER_SW2) = ‘0’ and (USER_SW3) =  

  ‘0’ to  return to the “Straight through, no recording” state.   

 f. Select switches (USER_SW1) = ‘0’, (USER_SW2) = ‘1’ and (USER_SW3) = 

 ‘0’ for “Up-Sampling Process” state.  This switch value correspond to the “2” 
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 value  in the decimal base.  This routine performs the Up-sampling process and 

 filter the stored samples on the “record_array” and stores the results on the 

 memory called “record_array_out”. 

 g. Select switches (USER_SW1) = ‘0’, (USER_SW2) = ‘0’ and (USER_SW3) =  

 ‘0’ to  return to the “Straight through, no recording” state.   

 h. Select switches (USER_SW1) = ‘0’, (USER_SW2) = ‘0’ and (USER_SW3) = 

 ‘1’ for “Playback Up_Sampling” state.  This switch value correspond to the “4” 

 value  in the decimal base.  This routine plays back the recorded sound from the 

 memory “record_array_out”of the DSK at the same Sampling Frequency as the 

 input sampling rate. 

 

 i. Select switches (USER_SW1) = ‘1’, (USER_SW2) = ‘0’ and (USER_SW3) = 

 ‘1’ for “Playback Down_Sampling” state.  This switch value correspond to the 

 “5”  value  in the decimal base.  This routine performs the Down-sampling 

 process and  plays the result at the new sampling frequency corresponding to 

 the desired Up/Down sampling rate chosen at the beginning. 

 j.   Select switches (USER_SW1) = ‘1’, (USER_SW2) = ‘1’ and (USER_SW3) = 

 ‘1’ for “record_arrays_clear” state.  This switch value correspond to the “7” 

 value  in the decimal base.  This routine performs a clean-up of the memory used 

 in the process, “record_array” and “record_array_out”.    

 k. Select switches (USER_SW1) = ‘0’, (USER_SW2) = ‘0’ and (USER_SW3) =  

 ‘0’ to  return to the “Straight through, no recording” state.  Now the DSK is 

 ready  for another recording and Multi-rate process with the same selected rate. 
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NOTE:   If the user wants to use the other rate, the user must stop the program and re-

load the Multirate.out file again.  Follow the step 2 used earlier. Here the user may select 

the rate again.  

 

 

Figure 5 Standard Out window of the Multirate program. 
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Routines Flow Chart 
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Project Results 

 

The Following figures shows, the final results of the Multirate Project. 

Figure A 

Channel 1: Original Input Signal (Vpp = 500mv and 1 KHz). 

Channel 2: Up-Sampled Signal by 2 

Fs(in) = 36 KHz. 

Fs(out) = 36 KHz. 

 

 

 

 

The picture shows that the signal in channel 2, up-sampled by 2, has half the frequency of 

the original input signal, presented in channel 1, because the Up_Sampling Process 

increases the size of the original input signal by 2.  To show that the Up_Sampling 

process works, we selected Fs (out) with equal value as Fs (in) so that the output signal, 
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with two times the samples as the original signal, comes out with half the frequency of 

the original signal.  It is important to know that the output signal has been filtered by LPF 

with cut frequency of pi/3 to interpolate the zero value samples added with the original 

samples and to eliminate the spectral images generated by the Up-sampler.     

Figure B 

Channel 1: Original Input Signal (Vpp = 500mv and 1 KHz ). 

Channel 2: Signal after Up/Down sampling processes, rate = 2/3 

Fs(in) = 36 KHz. 

Fs(out) = 24 KHz. 

 

 

 

The picture shows that the signal in channel 2, after the Up/Down sampling processes, 

has the same frequency that of the original recorded signal.  The reason for this is that the 

input signal’s sampling frequency, Fs(in) = 36 KHz, is multiplied by the Up/Down 

sampling rate = 2/3, resulting in a output sampling frequency, Fs(out) = 24 KHz.  To 
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show that the Up/Down sampling processes works, we selected Fs(out) = 24 KHz in 

order to reproduce correctly the input signal.  The signal has been filtered to eliminate the 

spectral images and possible aliasing created by the Up-sampler and Down-sampler 

respectively.  

Figure C 

Channel 1: Original Input Signal (Vpp = 500mv and 1 KHz ). 

Channel 2: Up-Sampled Signal by 3 

Fs(in) = 24 KHz. 

Fs(out) = 24 KHz. 

 

 

The picture shows that the signal in channel 2, up-sampled by 3, has 1/3 the frequency of 

the Original Input Signal, presented in channel 1, because the Up_Sampling Process 

increases the size of the Original Input Signal by 3.  To show that the Up_Sampling 

process works, we selected Fs (out) with equal value as Fs (in) so that the output signal, 

with three times the samples as the original signal, comes out with 1/3 the frequency of 
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the original signal.  It is important to know that the output signal has been filtered by LPF 

with cut frequency of pi/3 to interpolate the zero value samples added with the original 

samples and to eliminate the spectral images generated by the Up-sampler. 

Figure D 

Channel 1: Original Input Signal (Vpp = 500mv and 1 KHz). 

Channel 2: Signal after Up/Down sampling processes, rate = 3/2 

Fs(in) = 24 KHz. 

Fs(out) = 36 KHz. 

 

 

 

The picture shows that the signal in channel 2, after the Up/Down sampling processes, 

has the same frequency that of the original recorded signal.  The reason for this is that the 

input signal’s sampling frequency, Fs(in) = 24 KHz, is multiplied by the Up/Down 

sampling rate = 3/2, resulting in a output sampling frequency, Fs(out) = 36 KHz.  To 

show that the Up/Down sampling processes works, we selected Fs(out) = 36 KHz in 
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order to reproduce correctly the input signal.  The signal has been filtered to eliminate the 

spectral images and possible aliasing created by the Up-sampler and Down-sampler 

respectively.  

Filter Design with MatLab  

We used MatLab as a tool for the filter design in this project for interpolation and spectral 

images rejection and as anti-aliasing.  We design a finite impulse response, FIR, filter 

with order of 13 and a cut frequency of   л/3.  We used the FIR1 command to generate 

the coefficients used by the implementation that are located in the file COEF_CLPF.h. 
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Conclusion: 

 

The Multi-rate system implementation on the TI’s TMS320C6711 DSP board was 

completed successfully.  We were able to implement a system capable of adapting an 

output signal from an initial system working at a sampling frequency of 24 KHz, to a 

system working at a sampling frequency of 36 KHz.  Also the implementation is capable 

of adapting the two systems, the sender system and the receiving system, with samples 

frequencies of 36 KHz and 24 KHz respectively.  This is proof that we could implement 

successfully the Up-sampling and Down-sampling concepts, also the interpolation by the 

use of FIR filters.   

 

We learned about the different features of the DSK board like the User Switches, 

the DSK Ram memory, the register for control like TIMER0 and TIMER1 to change the 

sampling rate, and the Audio Daughter Card for high frequency sampling and flexibility 

with the sampling rates frequencies by controlling it by software. 

Most importantly we gained knowledge about the C++ programming for DSP 

applications using the CCS, Code Composer Studio, software tool, also the experience in 

designing a complete DSP application, which will be helpful on our development as 

engineers.   
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B. DBT Tool box Example 
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C. Time Frequency Algorithms 
 
/************************************************** ********************
* 
* AIP Laboratory  
* 
* AF.C 
* 
* DESCRIPTION 
*  This program compute the Ambiguity Function betw een the Tx and Rx  
*  signals. 
* 
*  DEVICE: DSK320C6711 T.I.    
*  CCS v. 2.1 
*-------------------------------------------------- -------------------- 
* HISTORY 
*   Rev 1.00 - Sep/2004  Created by MS. William D. Sánchez R. 
*        Dr. Domingo Rodríguez - Advisor 
* 
*************************************************** *******************/ 
// Included Files// 
#include  "math.h"  // math.h header for mathematical operations. 
#include  "dataTW256.h"  // Twiddle Factors to compute a N-point FFT. 
#include  "Sgtx256.h"    // Signal transmmitted. 
#include  "Sgrx256.h"    // Signal Received. 
#include  "Xcorr256.h"   // Correlation File initialized with "0.0". 
#include  "c6211dsk.h"   // c6211dsk. header for dsk function routines 
/////////////////////////////////////////////////// //////////////////// 
 
#define  N 256           // Points of the Signals and FFT points 
 
 
 
//Storage Matrix// 
far double  Ambiguity_Mtx[N][2*N]; // far - location, of the Ambiguity 
Function [Rows][ComplexColumns]. 
/////////////////////////////////////////////////// //////////////////// 
 
/*------------------------------------------------- -------------------- 
* NAME: Coplex_Complement(void) 
* DESCRIPTION: Perform the complement to R = (R + j 0) Real data stored  
  
*      in Ambiguity_Mtx[m][n], 
* ARGUMENTS:   Uses the general Variable Ambiguity_ Mtx               
* 
*************************************************** *******************/ 
 
void  Complex_Complement( void ) 
{ 
 
int  n,m; 
 
for  (m=0; m<N; m+=1) 
 { 
     for  (n=(N-1); n>=0;n-=1) 
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   { 
    Ambiguity_Mtx[m][2*n] = Ambiguity_Mtx[m][n]; 
    Ambiguity_Mtx[m][2*n+1] = 0; 
    } 
     
 } 
} 
/////////////////////////////////////////////////// //////////////////// 
 
/*------------------------------------------------- -------------------- 
* NAME: FFT_TI (void) 
* DESCRIPTION: Perform the FFT of each row of the A mbiguity_Mtx[m]  
*       
* ARGUMENTS:   Uses the general Variable Ambiguity_ Mtx               
* 
*************************************************** *******************/ 
 
void  FFT_TI ( void )  
{ 
int  m; 
double  *pointer1; 
 
//bit_rev((float *)w, N>>1);  
 
for  (m=0; m<N; m+=1) 
 { 
   
  pointer1 = Ambiguity_Mtx[m]; 
  DSPF_sp_cfftr2_dit(( double *) pointer1,( float *) w, N); 
  bit_rev(( double  *)pointer1, (2*N)>>1); 
     
 }    
 
} 
 
/////////////////////////////////////////////////// //////////////////// 
 
/*------------------------------------------------- -------------------- 
* NAME: Haddamart (double Stx[])  
* DESCRIPTION: Perform the Haddamart product betwee n Tx and the Matrix 
family of   
*      shifthed Rx signal 
* ARGUMENTS:   The Tx signal vector.                
* 
*************************************************** *******************/ 
 
void  Haddamart ( double  Stx[])  
{ 
int  n,m; 
 
for  (m=0; m<N; m+=1) 
 { 
  for  (n=0; n<N;n+=1) 
   { 
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    Ambiguity_Mtx[m][n]= 
(Ambiguity_Mtx[m][n]*Stx[n]); //Fam_Shift[m][n]= 
(Fam_Shift[m][n]*Stx[n]); 
    } 
 }    
 
} 
 
/////////////////////////////////////////////////// //////////////////// 
 
/*------------------------------------------------- -------------------- 
* NAME: Shift_Signal (double Srx[]) 
* DESCRIPTION: Create a Matrix of Cyclic Shifth Rx signal 
* ARGUMENTS:   The Rx signal vector                
* 
*************************************************** *******************/ 
 
void  Shift_Signal ( double  Srx[])  
{ 
int  n,m,i; 
 
for  (m=0; m<N; m+=1) 
 { 
  for  (n=0; n<N;n+=1) 
   { 
    i=(n+m)%N; 
    Ambiguity_Mtx[m][n]= (Srx[i]); //Fam_Shift[m][n]= 
(Srx[i]); 
    } 
 }    
 
} 
/////////////////////////////////////////////////// //////////////////// 
 
/*------------------------------------------------- -------------------- 
* NAME: Corr(double Stx[], double Srx[]) 
* DESCRIPTION:Perform the Cross-correlation between  the Tx and Rx 
Signal. 
* ARGUMENTS:  The Tx signal vector and  the Rx sign al vector.              
* 
*************************************************** *******************/ 
 
void  Corr( double  Stx[], double  Srx[])  
{ 
int  n,m,i; 
 
for  (m=0; m<N; m+=1) 
 { 
  for  (n=0; n<N;n+=1) 
   { 
    i=(n+m)%N; 
    Xcorr[m]= (Stx[n]*Srx[i])+Xcorr[m]; 
    } 
 }    
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} 
 
/////////////////////////////////////////////////// //////////////////// 
 
/* Main program */ 
void  main() 
{  
 
Corr(Sigtx, Sigrx );  //Cross-correlation between the Tx and Rx Signal. 
 
Shift_Signal (Sigrx); //Cyclic Shifth Rx signal 
 
Haddamart (Sigtx);    // Haddamart Product 
 
Complex_Complement(); // R = (R+j0) 
 
FFT_TI();     // FFT  Matrix's rows  Ambiguity_Mtx. 
                                         
  
} 
/////////////////////////////////////////////////// //////////////////// 
 
 

 

 

/************************************************** ********************
* 
* AIP, Laboratory.  
* 
* STFT.C 
* 
* DESCRIPTION 
*  This program compute the Short Time Fourier Tran sform 
*  (STFT)of a Shirp Signal, Using the method of ind irect 
*  filtering (FFT) . 
* 
* DEVICE: DSK320C6711 T.I.    
* CCS v. 2.1 
*-------------------------------------------------- -------------------- 
* HISTORY 
*   Rev 1.00 - Sep/2004  Created by MS. William D. Sánchez R. 
*                  Dr. Domingo Rodríguez - 
Advisor 
* 
*************************************************** *******************/ 
 
/* Define Variables */ 
#define  N  256    // number of filters banks 
#define  P  1024    // Points of the signal Padded 
#define  L  128    // Points of the filter without 
padding 
#define  M  P-L    // Point of the input Chirp Signal 
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#define  fs 1000             // frequency sampling 
#define  D  1.024            // time durantion in seconds 
/////////////////////////////////////////////////// //////////////////// 
 
//Storage Matrix// 
far double  xk[N][2*P]; // far - location, of the STFT 
//[Rows][ComplexColumns]. 
/////////////////////////////////////////////////// //////////////////// 
 
// Included Files// 
#include  "math.h"   // math.h header for mathematical 
operations. 
#include  "c6211dsk.h"  // c6211dsk. header for dsk function 
routines 
#include  "dataTW1024.h"  // Twiddle Factors to compute a P-point 
FFT. 
#include  "chirpSTFT_896.h"  // Chirp input Signal with  M-points. 
#include  "fft_h_padd_128.h" // FFT ( of the L-points filter with pading  
//       // to P-points). 
/////////////////////////////////////////////////// //////////////////// 
 
 
 
 
 
 
 
 
/*------------------------------------------------- -------------------- 
* NAME: Haddamart (double *fft_h) 
* DESCRIPTION: Perform the Haddamart product betwee n aech row of the 
*      modulated Array and fft_h. FFT(xk[m][n]) .* FFT_h 
*       
* ARGUMENTS:   The fft_h coeficientes = FFT (h_padd ed).               
* 
*************************************************** *******************/ 
void  Haddamart ( double  *fft_h)  
{ 
int  n,m; 
double  y1,y2,y3,y4; 
 
for  (m=0; m<N; m+=1) 
 { 
  for  (n=0; n<P;n+=1) 
   { 
     
    y1 = xk[m][2*n]*fft_h[2*n]; 
    y2 = -1*(xk[m][2*n+1]*fft_h[2*n+1]); 
    y3 = xk[m][2*n]*fft_h[2*n+1]; 
    y4 = xk[m][2*n+1]*fft_h[2*n]; 
     
    xk[m][2*n]= y1+y2; 
    xk[m][2*n+1]= y3+y4; 
     
    } 
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 }    
 
} 
/////////////////////////////////////////////////// //////////////////// 
/*------------------------------------------------- -------------------- 
* NAME: FFT_TI (void) 
* DESCRIPTION: Perform the FFT of each row on the m odulated Array 
*      FFT(xk[row][n]. 
*       
* ARGUMENTS:   Uses the general variable matrix xk[ m][n].               
* 
*************************************************** *******************/ 
 
void  FFT_TI ( void )  
{ 
int  m; 
double  *pointer1; 
 
//bit_rev((float *)w, N>>1);  
 
for  (m=0; m<N; m+=1) 
 { 
   
  pointer1 = xk[m];       // pointer to the rows of the xk matrix. 
  DSPF_sp_cfftr2_dit(( double *) pointer1,( float *) w, P); 
  bit_rev(( double  *)pointer1, (2*P)>>1); 
     
 }    
 
} 
/////////////////////////////////////////////////// //////////////////// 
/*------------------------------------------------- -------------------- 
* NAME: In_FFT_TI (void) 
* DESCRIPTION: Inverse FFT, using the complex compl ement of the  
*              Twidel factor. IFFT(FFT(xk[m][n]) .*  FFT_h)/P. 
*       
* ARGUMENTS:   Uses the general variable matrix xk[ m][n].               
* 
*************************************************** *******************/ 
void  In_FFT_TI ( void )    
{ 
int  m,n; 
double  *pointer1; 
 
//bit_rev((float *)w, N>>1);  
 
for  (m=0; m<N; m+=1) 
 { 
   
  pointer1 = xk[m];  // pointer to the rows of the xk 
matrix.   
  In_DSPF_sp_cfftr2_dit(( double *) pointer1,( float *) w, P); 
  bit_rev(( double  *)pointer1, (2*P)>>1); 
     
 }    
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for  (m=0; m<N; m+=1)  // The output has to be divided by P-points. 
 { 
  for  (n=0; n<2*P; n+=1) 
  {  
   xk[m][n]=(xk[m][n])/P; 
  } 
 }  
} 
/////////////////////////////////////////////////// //////////////////// 
/*------------------------------------------------- -------------------- 
* NAME: Matrix_modulation(double *x)  
* DESCRIPTION: Modulation of the input Chirp Signal  with e^(wk) 
*       
* ARGUMENTS:   Uses the input Chirp Signal stored o n x[n].               
* 
*************************************************** *******************/ 
void  Matrix_modulation( double  *x)  
{ 
int  k,n,t; 
double  wk; 
double  pi = 4.0*atan(1.0); 
 
t = fs*D;   
 
for  (k=0; k<N; k+=1) 
 { 
  wk = (2*pi*k)/N; 
   
  for  (n=0; n<t; n+=1) 
   { 
    xk[k][2*n] = cos(wk*n)*x[2*n]; 
    xk[k][2*n+1] = (sin(wk*n)*x[2*n])*-1; 
//Modulation Matrix 
     
   } 
 }    
} 
 
 
 
/* Main program */ 
void  main() 
{  
 
Matrix_modulation(( double *) X); //Modulation of input Chirp Signal. 
 
FFT_TI();     // FFT of rows of the Modulation Matrix. 
 
Haddamart (( double *) h);        // Haddamart product between each  row  
//                              // of Modulation Ma trix and fft_h. 
 
In_FFT_TI();     // inverse fft, we don't have magnitude 
                                               
} 
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D. Multirate Beamforming Algorithm. 
 
 
/************************************************** ********************
* 
* AIP, Laboratory.  
* 
* BeamForming.C 
* 
* DESCRIPTION 
*  This program perform a "P" beam-forming from "N"  sensor array.  
*  with the S Down-Sampling factor. 
*   
* 
* DEVICE: DSK320C6711 T.I.    
* CCS v. 2.1 
*-------------------------------------------------- -------------------- 
* HISTORY 
*   Rev 1.00 - Sep/2004  Created by MS. William D. Sánchez R. 
*                  Dr. Domingo Rodríguez - 
Advisor 
* 
*************************************************** *******************/ 
 
/* Define Variables */ 
 
#include  "math.h" 
#include  "c6211dsk.h" 
 
 
/* Define sample rate */ 
float  Fs=40000.0; 
 
#define  N  32       // number of Sensors Array.  
#define  L_d 2       // lambda/d (distance). 
#define  p   2       // pth output of DFT. 
#define  B0   p*L_d/N // Covered beams, p = 0,1,2,3,....N-1. 
#define  ch p 
#define  r p 
#define  B 256       // Number of vectors sampling over all sensors. 
#define  P 8         //points of fft to evaluate the number of beams. 
#define  S 1         // Down-Sampling factor.  
double  FFT_Vec[2*P]; // Vector for store rows and perform FFT. 
/////////////////////////////////////////////////// //////////////////// 
// Included Files// 
#include  "dataTW8.h"      // Twiddle Factor to Compute the P-FFT 
#include  "Beam_256_32.h"  // Input Signal Simulated from Matlab 
(Matrix_complex (B x N). 
#include  "FFT_Sum_256_8.h" // Output Matrix_complex (B x P). each 
colomn represent a entire beam. 
/////////////////////////////////////////////////// //////////////////// 
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/*------------------------------------------------- -------------------- 
* NAME: Sum_FFT_Coherent(double* x, int fila) 
* DESCRIPTION: Perform the Coherent Sum for each ro w      
*       
* ARGUMENTS:   Pointer to the row in after fft *x a nd, the column in 
process.                
* 
*************************************************** *******************/ 
 
void  Sum_FFT_Coherent( double * x, int  fila)  
{ 
int  m,n; 
   
m= fila; 
 
 for  (n=0; n<2*P; n+=1) 
 { 
 FFT_Sum[m][n]= x[n]+FFT_Sum[m][n];  
 } 
    
} 
/////////////////////////////////////////////////// //////////////////// 
/*------------------------------------------------- -------------------- 
* NAME: FFT_TI_Beam (void)  
* DESCRIPTION: For each N-points rows divide by P-p oints and perform 
the P-points fft.      
*      with the S Down-Sampling factor. to reduce 
computations. 
* ARGUMENTS:   Uses the general variable matrix Bea m_M and FFT_Vec. 
               
* 
*************************************************** *******************/ 
 
void  FFT_TI_Beam ( void )  
{ 
int  m,n,i,k,j; 
double  *pointer1; 
 
 
i=0; 
k=1; 
j=0; 
 
//bit_rev((float *)w, N>>1);  
 
for  (m=0; m<B; m+=S) 
 { 
  for  (n=i; n<N; n+=1)  
  { 
  FFT_Vec[2*j]= Beam_M[m][2*n]; 
  FFT_Vec[2*j+1]= Beam_M[m][2*n+1]; 
  j++; 
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  if  (n == k*P-1) 
  { 
   j=0; 
   k++; 
   i+=k*P; 
   pointer1 = FFT_Vec; 
    DSPF_sp_cfftr2_dit(( double *) pointer1,( float *) w, P); 
    bit_rev(( double *)pointer1, (2*P)>>1); 
    Sum_FFT_Coherent(( double *)pointer1, m); 
   }; 
   
  }      
 i=0; 
 k=1; 
 } 
  
} 
/////////////////////////////////////////////////// //////////////////// 
 
 
/* Main program */ 
void  main() 
{  
 
FFT_TI_Beam(); // Routine to compute the "B" sampling vectors to c ompute  
         // "P" Beamforming. with the "S" Down-Sampling fact or.  
                    
} 
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E. Kronecker Properties Examples. 
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• Scalar Multiplication:  If α  is a scalar, then 
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• Distributive Law:  The Kronecker product is distributive with respect to addition 
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• Associative Law: The Kronecker product is associative 
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• Identity Product : Given rcI , the cr × identity matrix, 

crrc III ⊗=
 

224 III ⊗=  
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• Transpose: The transpose for both matrix and tensor operations is useful for 

manipulating symmetric matrices (e.g. the Fourier matrix), where the original 

matrix and the transpose are equal. 

TTT ABAB =)(  
TTT BABA ⊗=⊗ )(  
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• Mixed Product Rule: Let A and C be MM ×  and B and D be NN × matrices. 

Thus, 
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F. Signal Processing Tools  

 

 This chapter concentrates on the main characteristics of hardware and software 

tools utilized around the implementation process of this thesis. We will start explaining 

the Digital Starter Kid DSK320C6711 of T.I. After that, we will review the most relevant 

characteristics of the DSP processor TMS320C6711 of T.I. In addition will see the 

Daughter Card PCM3003 of T.I., the Analog to Digital converter ADS8364 of T.I., the 

signal conditioner card AIP-0404-1 and the software of development Code Composer 

Studio based on C language CCS 2.1v. 

 

1. Digital Starter Kit DSK320C6711 

 

The TMS320C6711 DSP Starter Kit (DSK) Figure 6, developed jointly 

with Spectrum Digital, is a low-cost improvement platform designed to speed the 

development of high precision applications based on TI´s TMS320C6000 floating 

point DSP generation [17]. The kit uses a parallel port to connect to PC.  The Code 

Composer Studio v2.1 was utilized.  

The C6711 DSK tools include the latest fast simulators from TI and access to the 

Analysis Toolkit via Update Advisor which features the Cache Analysis tool and Multi-

event Profiler.  

The C6711 DSK allows downloading and stepping through code quickly and uses 

Real Time Data Exchange (RTDX™) for improved Host and Target communications. 
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The DSK includes the Fast Run Time Support libraries and utilities, such as Flashburn to 

program flash, Update Advisor to download tools, utilities and software and a power on 

self test and diagnostic utility to ensure the DSK is operating correctly. 

The full contents of the kit include: 

• C6711 DSP Development Board with 64K Flash and 16MB SDRAM  

• C6711 DSK Code Composer Studio™ v2.1  

• Quick Start Guide  

• Technical Reference  

• Customer Support Guide  

• Parallel Cable  

• Universal Power Supply  

• AC Power Cord(s)  

 

 

 

 

 

 

 

 

Figure 6 Digital Starter Kid DSK320C6711 of Texas Instruments 
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1.2 TMS320C6711 DSP Processor 

 

The C6711 device, Figure 7, is based on the high-performance, advanced 

VelociTI™ very-long-instruction-word (VLIW) architecture developed by Texas 

Instruments (TI) [17]. It makes this DSP an excellent choice for multichannel and 

multifunction applications. With performance of up to 900 million floating-point 

operations per second (MFLOPS) at a clock rate of 150 MHz, the C6711 device offers 

cost-effective solutions to high-performance DSP programming challenges. The C6711 

DSP possesses the operational flexibility of high-speed controllers and the numerical 

capability of array processors. This processor has 32 general-purpose registers of 32-bit 

word length and eight highly independent functional units. The eight functional units 

provide four floating-/fixed-point ALUs, two fixed-point ALUs, and two floating-/fixed-

point multipliers. The C6711 can produce two MACs per cycle for a total of 300 

MMACS. 

With performance of up to 1200 million floating-point operations per second 

(MFLOPS) at a clock rate of 200 MHz or 1350 MFLOPS at a clock rate of 250 MHz (for 

6711D), the C6711 device also offers cost-effective solutions to high-performance DSP 

programming challenges. The C6711 DSP also possesses the operational flexibility of 

high-speed controllers and the numerical capability of array processors. This processor 

has 32 general-purpose registers of 32-bit word length and eight highly independent 

functional units. The eight functional units provide four floating-/fixed-point ALUs, two 

fixed-point ALUs, and two floating-/fixed-point multipliers. The C6711 can produce two 

MACs per cycle for a total of 400 MMACS. 
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The C6711 DSP also has application-specific hardware logic, on-chip memory, 

and additional on-chip peripherals. This C6711 uses a two-level cache-based architecture 

and has a powerful and diverse set of peripherals. The Level 1 program cache (L1P) is a 

4-Kbit direct mapped cache and the Level 1 data cache (L1D) is a 64-Kbit 2-way set-

associative cache. The Level 2 memory/cache (L2) consists of a 64-Kbit memory space 

that is shared between program and data space. L2 memory can be configured as mapped 

memory, cache, or combinations of the two.  

 

 

Figure 7. Functional Block Diagram and CPU for DSP320C6711. [spru190 source]. 
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The peripheral set includes two multichannel buffered serial ports (McBSPs), two 

general-purpose timers, a host-port interface (HPI), and a glueless external memory 

interface (EMIF) capable of interfacing to SDRAM, and asynchronous peripherals. 

The C6711 has a complete set of development tools which includes: C compiler, 

an assembly optimizer to simplify programming and scheduling, and a Windows™ 

debugger interface for visibility into source code execution. 

 

1.3 Audio Daughter Card PCM3003 

 

PCM3003 Figure 8, shows a low cost single chip stereo audio CODECs (analog-

to-digital and digital-to-analog converters) with single-ended analog voltage input and 

output. The ADCs and DACs employ delta-sigma modulation with 64X oversampling. 

The ADCs include a digital decimation filter, and the DACs include an 8X oversampling 

digital interpolation filter [17]. The DACs also include digital attenuation, de-emphasis, 

infinite zero detection and soft mute to form a complete subsystem. 

PCM3003 operates with left-justified and right-justified formats. PCM3003 

provides a power-down mode that operates on the ADCs and DACs independently. 

Fabricated on a highly advanced CMOS process, PCM3003 is suitable for a wide variety 

of cost-sensitive consumer applications where good performance is required. The 

PCM3003’s functions include  
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Figure 8. Audio Daughter Card PCM3003 of Texas Instruments 

 

deemphasize, power down, and audio data format selections, which are controlled by hardware. 

Hardware Features 

• Board Size: 3.5" x 3" Inches  

• PCM3003 - Burr Brown 16-/20-Bit Single-Ended Analog Input/Output Stereo 

Audio Codec (TI Lit. # SPAS079)  

• Compatible with TI C31 and C6711 DSKs (attaches via header connector)  

• Line-in/out stereo mini audio jacks  

• 2 electrets microphones  

• Sample rate controlled by 12.288 MHz Oscillator or by DSP timer output pin.  

• Separate Analog/Digital power regulators and ground planes for high-resolution 

audio.  

• Jumper Configurations  

• 20/16-bit codec selection  
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• Clock sample rates  

• Jack/Microphone selection  

• Line/Microphone input gain control selection  

• Oscillator/DSP Timer selection  

• Sampling rate Jumpers 

• Software Features 

 

1.4 Evaluation Module ADS8364EVM 

 

ADS8364 Figure 9, shows a high-speed, low power, dual 16-bit A/D converter 

that operates from independent 5-V AVdd and DVdd supplies [17]. The digital output is 

delivered through a built-in buffer circuit that can be powered from DVdd or separate 

2.7-V to 5.5-V (BVdd) sources. This allows for flexibility when designing within mixed 

voltage environments.  

The ADS8364EVM includes the following features: 

• Full-featured evaluation board for the ADS8364 250-kHz, 16-bit, 6-channel, 

simultaneous sampling A/D converter  

• Analog inputs can be configured as single-ended or differential  

• Direct connection to C5000 and C6000 DSK platforms through the 80-pin 

interface connectors  

• Built-in reference  

• High-speed parallel interface  
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Figure 9 Six-Analog to Digital Converter ADS8364 

 

1.5 Signal Conditioner Adapter AIP-0404-1 

  

AIP-0404-1 Figure 10, shows a hardware prototype developed at the AIP-

Laboratory and fully implemented to perform the signal conditioner between the 6-

channels (A/D converters) of the ADS8364EVM and the external analog signals in our 

case a sensor array of 6-microphones [17]. It is developed to introduce a 2.5 V-DC offset 

and gain factor of 5, in order to offer a correct input signal to the A/Ds converter 

references. This allows the possibility to connect different input sensors not only 

microphones to the A/Ds converters. The device AIP-0404-1 is based on the LM3900 

OpAmp (Operational Amplifier), this offers good characteristics of input and output 

impedances.  The schematic connection is shown in Figure 11.  

The AIP-0404-1 includes the following features: 
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• Six-channels A/D signal conditioner adapter. 

• Six-Analog inputs and outputs. 

•  Direct connection to the ADS8364EVM and external analog six-sensors. 

• Only one 5 VDC input supply.   

• Six input plug connectors. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 10. Signal Conditional Adapter for six-channels AIP-0404-1 
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Figure 11. Signal Conditional Adapter Schematic Connection 
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2. Software Development Tool 

 

Code Composer StudioTM (CCStudio) Development Tools are a key element of 

the eXpressDSP Software and Development Tools strategy from Texas Instruments. 

CCStudio delivers all of the host tools and runtime software support for your TMS320 

DSP based real-time embedded application to market faster [17]. Familiar tools and 

interfaces allow users to get started faster than ever before and add functionality to their 

application thanks to sophisticated productivity tools. CCStudio's easy to use 

development environment allows DSP designers of all experience levels to move quickly 

through each phase of the application development process including design, code and 

build, debug, analyze and optimize. The fully integrated development environment 

includes real-time analysis capabilities, easy to use debugger, C/C++ Compiler, 

Assembler, linker, editor, visual project manager, simulators, XDS560 and XDS510 

emulation drivers and DSP/BIOS support. 

 Code Composer Studio's fully integrated Host Tools include: 

• TMS320 DSPs C/C++ compiler, assembler, linker and visual linker with 

optimization feedback 

• XDS560™ high speed emulation drivers  

• XDS510™ emulation drivers  

• Simulators for full devices, CPU only and CPU plus memory for optimal 

performance  

• Integrated Visual Project Manager with source control interface, multi-project 

support and the ability to handle 1000's of project files  
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• Editor with CodeMaestro™ technology to simplify the creation of C/C++ 

programs  

• Source Code Debugger common interface for both simulator and emulator targets  

• C/C++/Assembly language support  

• Simple breakpoints  

• Advanced and Hardware breakpoints (Hardware target only)  

• Probe points for data injection/extraction  

• Pin Connect, Port Connect for simulating real world interfaces (Simulator target 

only)  

• Advanced Watch Window  

• Symbol Browser  

• DSP/BIOS™ Host Tooling Support (Configure, Real-time analysis and Debug)  

• RTDX™ data transfer for real time data exchange between host and target  

• Parallel Debug Manager to support multi-processor board debug and analysis  

• Profiler to understand code performance  

• Update Advisor to keep your system current with the latest releases from TI 

(requires active subscription)  

• Data ConverterPlug-in to auto configure support for Texas Instruments Mixed 

Signal products  

• Online Context Sensitive help  

• Online Tutorial for getting started  
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• CCStudio also delivers critical time saving software for your target application 

consisting of: 

• DSP/BIOS™ Kernel for the TMS320C5000 DSPs (DSP/BIOS™ license included 

with purchase of Code Composer Studio)  

• Pre-emptive multi-threading  

• Interthread communication  

• Interrupt Handling  

• Chip Support Library  

• TMS320 DSP Algorithm Standard to enable software reuse  

• Chip Support Libraries to simplify device configuration  

• DSP Libraries for optimum DSP functionality  

• Reference Frameworks - production quality starter code to get you coding faster  

• TMS320 DSP Algorithm Standard Developer Kit v2.1 with  

• Analysis Toolkit to analyze code performance, including multi-event profiler, 

code coverage and cache analysis  

 

 
 

 


